Manual > Payment on Voluntary Basis (FORM GST DRC-03)
How can | make payment against the liability (tax, interest, penalty and others) based on self-ascertainment of tax?
To make payment against the liability (tax, interest and penalty) based on self-ascertainment of tax, perform following steps:

1. Access the www.gst.gov.in URL. The GST Home page is displayed. Login to the GST Portal with valid credentials. Click the Services > User Services > My Applications

option.

Services = GST Law Search Taxpayer ~ Help ~ e-Way Bill System
Registration Ledgers Returns Payments User Services Refunds
My Saved Applications My Applications
View/Download Certificates Wiew Motices and Orders
View My Submissions Contacts
Search HSM / Service Classification Code Haoliday List
Feedback Grievance / Complaints
Generate User Id for Advance Ruling Furnish Letter of Undertaking (LUT)
View My Submitted LUTs Locate GST Practitioner (GSTP)
Engage / Disengage GST Practitioner (GSTP) ITC02-Pending for action

2. Select the Intimation of Voluntary Payment - DRC - 03 from the Application Type drop-down list. Click the NEW APPLICATION button.



Application Typa* From Date To Date

Select v | DB/MM/YYYY . DD/MM/YYYY |

Advance Ruling
Intimation of Voluntary Payment - DRC-03 SEARCH NEW APPLICATION

Letter OF Undertaking
Appeal to Appellate Authority

3. The Intimation of payment made voluntarily or made against the show cause notice (SCN) page is displayed.
Note: Application for intimation of voluntary payment can be saved at any stage of completion for a maximum time period of 15 days. If the same is not filed within 15 days, the
saved draft will be purged from the GST database. To view your saved application, navigate to Services > User Services > My Saved Applications option.

Intimation of payment made voluntarily or made against the show cause notice (SCN)

GSTIN/UIM/Temp Id - Legal Name - HARIDAS MARUTI Trade Name - Haridas Status - DRAFT
07DCMPS3222R172V SHIMDE

*® Indicates Mandatory Fields

Cause Of Payment®

Select ¥
Section Number® Financial Year"®
Select T Select r

Overall Tax Period

Select T Select r Select v Select v




Details of payment made including interest and penalty, if applicable

Select v Select v Select v Select v Select Tax Act Type ¥ Select Place of Supply
gy b

ADD

4. Select the Cause of Payment from the drop-down list.

Cause Of Payment*

ITC Mismatch - GSTR-2A/2B to GSTR-3E +

Select

Voluntary

SCN

Annual return

Reconciliation statement

Liability Mismatch - GSTR-1 to GSTR-3B

ITC Mismatch - GSTR-2A/2B to GSTR-3B
Others

4.1 In Case of Voluntary Payment

Payment date is auto-populated and cannot be edited.



Cause Of Payment*® Payment Date

Voluntary ¥ 22/10/2019

4.2 In Case of SCN

a. Select Manual Entry from the SCN Reference Number drop-down list and enter the SCN Reference Number.

b. Select the SCN Issue Date using the calendar.
Note: SCN Issue date should be within last 30 days.

Cause Of Payment® SCN Reference Number®

SCM r Enter valid SCN number

Issue Date®
DDy MM Yy

@ Issue date should be within last 30 days

]

4.3 In Case of Annual Return

Cause Of Payment® Payment Date
Annual return v 30/10/2019
Section Number* Financial Year"®

Select v Select

Select

4.4 In Case of Reconciliation Statement




Cause Of Payment* Payment Date
Reconciliation statement v 30/10/2019

Section Number*® Financial Year*®
Select T Select r
Select '

5. Select the Section Number from the drop-down list.

Section Number®

Select A

Select
73(8)
74(8)
63

76
122
123
124
125
127
129
130

6. Select the Financial Year and From date and To Date for Overall tax Period from the drop-down list.
7. Enter the Details of payment made including interest, penalty and others.

Skip to Main Content & A* A"

Goods and Services Tax & Bhogovalli shailaja v

07FBXPS5061N271




Dashboard Services - GST Law

Dashboard © Services © User Services -~ My Applications

Downloads -

Search Taxpayer ~

Help ~

Intimation Of Voluntary Payment

Intimation of payment made voluntarily or made against the show cause notice (SCN)

GSTIN/UIN/Temp Id -
07FBXPS5061N2Z1

Cause Of Payment*

Voluntary v

Section Number*®

73(5) v

Legal Name - Bhogovalli shailaja

Trade Name - Trade

Payment Date

25/10/2019

Financial Year®

2018-2019 ¥

Overall Tax Period

e-Way Bill System

New Return (Trial) -

Status - DRAFT

® Indicates Mandatory Fields

JAN ¥ 2019

¥ MAR

Details of payment made including interest and penalty, if applicable

Tax Period

JAN ¥ 2019 ¥ MAR
JAN ¥ 2019 ¥ JAN
JAN ¥ 2019 ¥ JAN

ACT TYPE
¥ 2019 ¥ IGST
¥ 2019 ¥ CGST
¥ 2019 ¥ s5GST

¥ 2019 ¥

Place of Supply (Name of State

v Delhi

v Select Place of Supply

v Select Place of Supply

Top

Top




Site best viewed at 1024 x 768 resolution in Internet Explorer 10+, Google Chrome 49+, Firefox 45+ and Safari 6+

8. Use the scroll bar to move to the right to enter more details.

Note: You can click the DELETE or ADD button to delete or add more payment details.
9. Click the PROCEED TO PAY button.

Goods and Services Tax

Dashboard Services ~ G5T Law Downloads - Search Taxpayer ~ Help ~

Dashboard - Services - User Services - My Applications - Intimation Of Voluntary Payment

Intimation of payment made voluntarily or made against the show cause notice (SCN)

ADD

SAVE PROCEED TO PAY

Skip to Main Content & A* A

& Bhogovalli shailaja ~
O7FBXPS5061N271

e-Way Bill System New Return (Trial) -

GSTIN/UIN/Temp Id -
07FBXPS5061N271

Legal Name - Bhogovalli shailaja Trade Name - Trade

Cause Of Payment* Payment Date

Voluntary 25/10/2019

Status - DRAFT

® Indicates Mandatory Fields




Section Number* Financial Year*
73(5) v 2018-2019 v
~
Top
Overall Tax Period
JAN r 2019 r MAR. r 2019 r
Details of payment made including interest and penalty, if applicable
Tax/Cess (X) Interest (X) Penalty (%) m Total () Actio
180000 0 ] 0 180000 n
~
Top
45500 0 ] 0 45500 n
45500 0 0 0 45500 u
4 »

Site best viewed at 1024 x 768 resolution in Internet Explorer 10+, Google Chrome 49+, Firefox 45+ and Safari 6+




The Voluntary Payment page is displayed.

Skip to Main Content @ AY A

Goods and Services Tax & Bhogovali shailaja v

07FBXPS5061N2Z1

Dashboard Services - GST Law Downloads ~ Search Taxpayer Help ~ e-Way Bill System New Return (Trial) ~

Dashboard = Utilize Funds

GSTIN/TEMP 1ID: Legal Name: Trade Name:
07FBXPS5061N2Z1 Bhogovalli shailaja Trade
Voluntary Payment
Liability (%)
Description
Integrated Tax (%) Central Tax State/UT Tax CESS
Tax #1,80,000 45,500 ¥45,500 20
Interest =0 20 =0 20
Penalty () 20 20 20 20
Fees (X) 20 20 20 20
Others 70 20 30 30
Cash Ledger Balance (%)
Description Description
Integrated Tax () Central Tax State/UT Tax CESS Int
Tax £99,330 20 20 g0 T
Interest Interest

30 0 0 0




Penalty (%)

0
Fees (%) Z0
Others Z0
4
Description
Available

Integrated 30
Tax (%)
Central Tax ¥56,367
State/UT

56,505
Tax
CESS F437

4

Reasons if any

Attachments

Choose File | Mo file chosen

©File with PDF or JPEG format is only allowed

OMaximum 4 files and 5 MB for each file allowed

Verification ®

20

0

20

Credit Ledger Balance (%)

Provisional

20

20

0

0

Blocked

20

0

20

Mismatch

20

20

0

0

20

0

20

20

20

0

0

Penalty (%)

Fees (%)

Others

Description
Int

Integrated
Tax (%)

Central Tax

~
Top
State/UT
Tax
CESS
3
~
Top

¥/ I hereby solemnly affirm and declare that the information given herein above is true and correct to the best of my knowledge
and belief and nothing has been concealed therefrom.

MName of Authorized Signatory ®

Bhogovalli shailaja[ FEXPS5061N]
Designation / Status

asdas

@ DSC is compulsory for companies and LLP.

T

Place*®

Gurgaon

Date
25/10/2019




BACK

PREVIEW CREATE CHALLAN FILE

Site best viewed at 1024 x 768 resolution in Internet Explorer 10+, Google Chrome 49+, Firefox 45+ and Safari 6+

10.1 Liability Details
Liability details are displayed as shown in below table.

Voluntary Payment

Liability (%)
Description
Integrated Tax (%) Central Tax State/UT Tax CESS

Tax #1,80,000 745,500 745,500 70
Interest 20 20 20 20
Penalty (%) 70 70 70 20
Fees () 20 20 20 20
Others 20 20 20 20

10.2 Cash Ledger Balance



The cash available as on date are shown in below table.

Note: Interest and penalty amount shall be paid out of cash ledger only.

Description

Tax

Interest

Penalty (%)

Fees (%)

Others

Integrated Tax (%)

F99,330

0

0

0

30

Cash Ledger Balance (%)

Central Tax State/UT Tax

0

0

0

0

0

20

0

20

0

<0

CESS

0

0

0

0

0

10.2.1 Use the scroll bar to move to the right to enter the amount to be paid through cash against the liability.




Description

Tax

Interest

Penalty (%)

Fees (%)

Others

Integrated Tax ()

799,330

20

20

0

0

Pay through Cash (%)

Central Tax State/UT Tax

20

20

20

0

0

0

20

0

0

0

CESS

0

20

0

0

F0

10.2.2 Use the scroll bar to move to the right to enter the amount to be paid through cash by creating challan against the liability.




Additional cash required (%)
Description

Integrated Tax () Central Tax State/UT Tax CESS
Tax 380,670 30 20 20
Interest 20 20 30 =0
Penalty () 20 30 20 20
Fees () 20 20 20 20
Others 20 20 20 20

10.3 Credit Ledger Balance
The ITC available as on date are shown in below table.

Skip to Main Content @ AY A

Goods and Services Tax & Bhogovali shailaja v

07FBXPS5061N2Z1

Dashboard Services - GST Law Downloads - Search Taxpayer - Help ~ e-Way Bill System New Return (Trial) ~

Dashboard = Utilize Funds

GSTIN/TEMP ID: Legal Name: Trade Name:
07FBXPS5061N2Z1 Bhogovalli shailaja Trade

Voluntary Payment




Liability (%)
Description

Integrated Tax (%) Central Tax State/UT Tax CESS
Tax %1,80,000 245,500 45,500 20
Interest =0 =0 =0 20
Penalty () z0 20 z0 20
Fees () 20 20 20 20
Others 70 20 30 30
Pay through Cash (%)
Description Description
Integrated Tax () Central Tax State/UT Tax CESS Int
Tax #1,80,000 20 20 g0 | TAX
~
Interest 70 20 20 20 Interest Top
Penalty (%) =0 =0 =0 =0 Penalty (%)
Fees (%) 20 20 20 20 Fees (%)
Others =0 =0 =0 =0 Others
| 3
Credit Ledger Balance (%)
Description Description
Available Provisional Blocked Mismatch Int
Integrated — - - - Integrated
Tax (%) Tax (%)
Central Tax 256,367 50 50 50 Central Tax
~
Top
State/UT State/UT
¥56,505 0 0 0
Tax Tax




CESS 7437 20 20 z0 |CESS

Reasons if any

Attachments
Choose File | No file chosen
©File with PDF or JPEG format is only allowed
OMaximum 4 files and 5 MB for each file allowed
Verification ® ~

Top
¥ I hereby solemnly affirm and declare that the information given herein above is true and correct to the best of my knowledge

and belief and nothing has been concealed therefrom.

MName of Authorized Signatory ® Place*®
Bhogovalli shailaja[ FEXPS5061N] v Gurgaon

Designation / Status Date

asdas 25/10/2019

@ DSC is compulsory for companies and LLP.

BACK

PREVIEW CREATE CHALLAN FILE

Site best viewed at 1024 x 768 resclution in Internet Explorer 10+, Google Chrome 49+, Firefox 45+ and Safari 6+

10.3.1 Use the scroll bar to move to the right to enter the amount to be paid through ITC against the liability.

Skip to Main Content @ A*Y A

Goods and Services Tax & Bhogovalli shailaja v

07FBXPS5061N2Z1




Dashboard Services ~ GST Law Downloads - Search Taxpayer ~ Help ~ e-Way Bill System New Return (Trial) ~

Dashboard = Utilize Funds

GSTIN/TEMP ID: Legal Name: Trade Name:
07FBXPS5061N2Z1 Bhogovalli shailaja Trade
Voluntary Payment
Liability (%)
Description
Integrated Tax (%) Central Tax State/UT Tax CESS
Tax #1,80,000 345,500 45,500 70
Interest 70 30 30 30
Penalty (%) z0 20 20 20
Fees (3) 20 20 20 0
Others z0 20 20 20
Additional cash required (%)
Description
CESS Integrated Tax (%) Central Tax State/UT Tax CESS
g0 | VX ¥80,670 0 20 20
~
zo @ Interest 70 70 70 70 Top
g0 | Penalty (%) 0 0 20 20
30  Fees(X) 30 30 30 30
Others

0 0 0 30 30




Paid through ITC (F)
Description

Mismatch Integrated Tax (%) Central Tax State/UT Tax CESS
- Integrated . . =0
Tax (%)
30 Central Tax 30 45,500
~
Top
State/UT
20 0 45,500
Tax
20 CESS 20
4
Reasons if any
Attachments
Choose File | No file chosen
@File with PDF or JPEG format is only allowed
OMaximum 4 files and 5 MB for each file allowed
Verification ® N
Top

¥/ T hereby solemnly affirm and declare that the information given herein above is true and correct to the best of my knowledge
and belief and nothing has been concealed therefrom.

MName of Authorized Signatory ® Place®
Bhogovalli shailaja[ FEXPS5061N] v Gurgacn

Designation / Status Date

asdas 25/10/2019

@ DSC is compulsory for companies and LLP.

BACK PREVIEW CREATE CHALLAN FILE




Site best viewed at 1024 x 768 resclution in Internet Explorer 10+, Google Chrome 49+, Firefox 45+ and Safari 6+

11. Select the Verification checkbox and enter the Name of Authorized Signatory and Place. Click the CREATE CHALLAN button.

Reasons if any

Attachments

Choose File | Mo file chosen
@File with PDF or JPEG format is only allowed
OrMaximum 4 files and 5 MB for each file allowed

Werification®

I hereby solemnly affirm and declare that the information given herein above is true and correct to the best of my knowledge
and belief and nothing has been concealed therefrom.

Mame of Authorized Signatory * Place*®
Bhogovalli shailzja]FBXPS5061N] ¥ Gurgaon

Designation / Status Date

asdas 25/10/2019

@ DSC is compulsory for companies and LLP.

BACK PREVIEW CREATE CHALLAN FILE

11.1 The Create Challan page is displayed. In the Tax Liability details grid, the Total Challan Amount field and Total Challan Amount (In Words) fields are auto-populated with
total amount of payment to be made. You cannot edit this amount.




Skip to Main Content @ AY A

Goods and Services Tax & Bhogovall shailaja v
07FBXPS5061N2Z1
Dashboard Services « G5T Law Downloads ~ Search Taxpayer ~ Help ~ e-Way Bill System New Return (Trial) -
Dashboard - Payment - Create Challan & English
Tax Liability
Tax ( T) Interest ( ¥) Penalty ( ¥) Fees ( ¥) Other ( ¥) Total ( ¥)
CGST(0005) 0 0 0 0 0
IGST(0008) 80670 0 0 0 80,670
CESS(0009) 0 0 0 0 0
Delhi
SGST(0006) 0 0 0 0 0
A
. _ Top
Total Challan Amount: ¥ 80,670 /
Total Challan Amount (In Words): Rupees Eighty Thousand Six hundred Seventy Only
Payment Modes*
= E-Payment
@ Over The Counter
@ NEFT/RTGS




Site best viewed at 1024 x 768 resolution in Internet Explorer 10+, Google Chrome 49+, Firefox 45+ and Safari 6+

11.2. Select the Payment Modes as E-Payment/ Over the Counter/ NEFT/RTGS. Click the GENERATE CHALLAN button.

Skip to Main Content & AY A

Goods and Services Tax & Bhogovalli shailaja v

07FBXPS5061N271

Dashboard Services « GST Law Downloads - Search Taxpayer ~ Help ~ e-Way Bill System New Return (Trial) -
Dashboard - Payment - Create Challan @ English
Tax Liability
Tax () Interest ( ¥) Penalty ( ¥) Fees ( ¥) Other ( ) Total ( ¥)
CGST(0005) 0 0 0 0 0
IGST(0008) 80670 0 0 0 80,670
CESS(0009) 0 0 0 0 0
Delhi
SGST(0006) L E E L L
~
. - Top
Total Challan Amount: Z 80,670/
Total Challan Amount (In Words): Rupees Eighty Thousand Six hundred Seventy Only
Payment Modes*
= E-Payment v
@ Over The Counter




@ NEFT/RTGS

Site best viewed at 1024 x 768 resolution in Internet Explorer 10+, Google Chrome 49+, Firefox 45+ and Safari 6+

11.3. The Challan is generated.

Goods and Services Tax

Dashboard Services - G5T Law Downloads - Search Taxpayer ~

Dashboard - Payment -~ Generate Challan

Challan successfully generated

GST Challan
CPIN Challan Generation Date
192100700000059 25/10/2019 13:02:52
Mode of Payment :- E-Payment

Details Of Taxpayer

GSTIN/Other Id Email Address
07FBXPS50061N27Z1 S20O00O0000@X0000000{om
Name Address

Bhogovalli shailaja 20000000 Delhi, 112232

NMataile Af Nanmeit

GENERATE CHALLAN

Skip to Main Content & AY A

& Bhogovalli shailaja ~
O7FBXPS5061N271

e-Way Bill System New Return (Trial) =

Challan Expiry Date
09/11/2019

Mobile Number

OXAUAXXK3I456

@ English

Top




LA icann-a Wi I_-'\p'JUJIL
Tax (T) Interest (%) Penalty () Fees (%) Other (%) Total ()
CGST(0005) 0 0 0 0 0 0
IGST(0008) 80,670 0 0 0 0 80,670
CESS(0009) 0 0 0 0 0 0
Delhi SGST(0006) 0 0 0 0 0 0
Total Challan Amount: Z 80,670 /- A
Top
Total Challan Amount (In Words): Rupees Eighty Thousand Six hundred Seventy Only
Select Mode of E-Payment*®
B Preferred Banks
B Net Banking
DOWNLOAD
@ If amount is deducted from bank account and not reflected in electronic cash ledger, you may raise grievance under
“Services>Payments:>Grievance against payment(GST PMT-07)"

Site best viewed at 1024 x 768 resolution in Internet Explorer 10+, Google Chrome 49+, Firefox 45+ and Safari 6+

Note:
In case of Net Banking: You will be directed to the Net Banking page of the selected Bank. The payment amount is shown at the Bank’s website.
In case of successful payment, you will be re-directed to the GST Portal where the transaction status will be displayed.

In case of Over the Counter:



Take a print out of the Challan and visit the selected Bank. Pay using Cash/ Cheque/ Demand Draft within the Challan’s validity period. Status of the payment will be updated on
the GST Portal after confirmation from the Bank.

In case of NEFT/ RTGS:

Take a print out of the Challan and visit the selected Bank. Mandate form will be generated simultaneously. Pay using Cheque or through your account with the selected Bank/
Branch. You can also pay using the account debit facility. The transaction will be processed by the Bank and RBI shall confirm the same within <2 hours>. Status of the payment
will be updated on the GST Portal after confirmation from the Bank.

Click here to refer the FAQs and User Manual on Making Payment.

12. A payment successfully completed message is displayed. The Bank Transaction ID is displayed on the screen. Click CONTINUE.


https://www.gst.gov.in/help/payments

Payment Summary

Your Payment is successfully completed.

Tax Remittance of Rs. 80670 via Bank Transacticn ID 191025070000002 successfully completed. View Receipt
Thank You!

Click here to view your Cash Ledger.

CONTINUE

18. Click the PREVIEW button to preview the draft in PDF format.

Goods and Services Tax

Dashboard Services - GST Law Downloads ~ Search Taxpayer - Help ~ e-Way Bill System

Dashboard = Utilize Funds

GSTIN/TEMP ID: Legal Name: Trade Name:

Skip to Main Content @ AY A

& Bhogovalli shailaja v
07FBXPS5061N271

New Return (Trial) ~




Description

Tax

Interest

Penalty (%)

Fees (%)

Others

Description

Tax

Interest

Penalty ()

Fees (%)

Others

Description

Integrated
Tax (%)

Central Tax

07FBXPS5061N2Z1

Integrated Tax (%)

¥1,80,000

Integrated Tax ()

¥1,80,000

20

30

20

30

Available

30

¥56,367

0

0

0

0

Bhogovalli shailaja

Central Tax

Liability (%)

45,500

20

30

20

30

Cash Ledger Balance (%)

Central Tax

0

20

0

20

0

Trade

State/UT Tax

State/UT Tax

Credit Ledger Balance (¥)

Provisional

0

20

Blocked

0

20

0

20

0

0

20

45,500

20

0

20

0

CESS

Mismatch

0

20

0

20

0

0

20

CESS

Description

Tax

Interest

Penalty (%)

Fees (%)

Others

Description

Integrated
Tax (%)

Central Tax

0

20

0

20

0

Int

Int

Top




State/UT

256,505 20
Tax
CESS 2437 20

Reasons if any

Attachments

Choose File | No file chosen
@File with PDF or JPEG format is only allowed

OMaximum 4 files and 5 MB for each file allowed

Verification ®

and belief and nothing has been concealed therefrom.
MName of Authorized Signatory ®
Bhogovalli shailaja[ FEXPS5061N]

Designation / Status
asdas

@ DSC is compulsory for companies and LLP.

State/UT
Z0 Z0

Tax
20 20 CESS

¥/ T hereby solemnly affirm and declare that the information given herein above is true and correct to the best of my knowledge

Place®
Gurgaon
Date
25/10/2019
BACK PREVIEW CREATE CHALLAN FILE

ted on

Site best viewed at 1024 x 768 resolution in Internet Explorer 10+, Google Chrome 49+, Firefox 45+ and Safari 6+

19. The draft statement in PDF format is downloaded on your computer. You can open the file to view details.

Top

Top

Top




FORM GST DRC - 03
[See rule 142(2)&142(3)]

Intimation of payment made voluntarily or made against the show cause notice {SCN) or statement

1. [ GSTIN D7FBXPS506TN2ZZI

2. | Name Bhogovalli shailaja

3. | Cause of Payment Woluntary

4. | Section under which voluntary payment is made 73(5)

5. | Details of show cause notice, if payment is made Reference No.: N.A Date OF issue - N.A.
within 30 days of its issue

6. | Financial Year 20182019

7. | Details of payment made including interest and penalty, if applicable (Amount inRs)

Sr. | Tax Periced | Act Place of Tax/Cess |Interest| Penalty,if |(Others Total Ledger utilised | Debit Date of

No supply applicable (Cash / Credit) | entry debit

(POS) no. entry

1 | JAN 2019- | IGST |Delhi 1,80,000.00 0 o 0|1,80,00000 - - -
MAR 2019

2 | JAN 2019- | CGST |Delhi 45,500.00 o 0 0| 4550060 - - -
JAN 2019

3 | JAN 2019- | SGST |Delhi 45500.00 0 0 0| 4550000 - - -
JAN 2019

8.Reasons, if any-

9 Verification-

| hereby solemnly affirm and declare that'the information given hereinabove is true and correct to the best of my knowledge and belief and
nothing has been concealed therefrom.

20. Before filing, In the Reasons if any field, enter the reasons.
21. Click the Choose File button to upload any document.
Note:

= File with PDF or JPEG format is only allowed

= Maximum 4 files and 5 MB for each file allowed
22. Select the Verification checkbox.
23. Select the Name of Authorized Signatory from the drop-down list.



24. In the Place field, enter the place where form is filled.
25. Click the FILE button.

Skip to Main Content @& AY A

Goods and Services Tax & Bhogovalli shalaja v

07FBXPS5061N271

Dashboard Services - G5T Law Downloads - Search Taxpayer - e-Way Bill System New Return (Trial) ~

Dashboard = Utilize Funds

GSTIN/TEMP ID: Legal Name: Trade Name:
07FBXPS5061N2ZI Bhogovalli shailaja Trade
Voluntary Payment
Liability ()
Description
Integrated Tax (%) Central Tax State/UT Tax CESS
Tax %1,80,000 45,500 45,500 20
Interest %0 30 20 %0
Penalty () z0 20 20 20
Fees (%) 20 20 20 20
Others z0 20 20 20
Additional cash required (%)
Description
CESS Integrated Tax (%) Central Tax State/UT Tax CESS

30 | Tax 20 20 20 20




interest

0 0

30 Penalty (%) 30

30 Fees (%) 30

30 Others 30

4
Description
Mismatch Integrated Tax (%)

- Integrated -
Tax (%)

50 Central Tax 50
State/UT

20 0
Tax

20 CESS

4

Reasons if any

Attachments

Choose File | No file chosen

@File with PDF or JPEG format is only allowed
OMaximum 4 files and 5 MB for each file allowed

Verification ®

¥/ T hereby solemnly affirm and declare that the information given herein above is true and correct to the best of my knowledge

and belief and nothing has been concealed therefrom.
MName of Authorized Signatory ®
Bhogovalli shailaja[FEXPS5061N]

Designation / Status
asdas

20

0

20

0

20

30

20

30

Paid through ITC (%)

Central Tax

0

45,500

Place*®
v Gurgaon

Date
25/10/2019

State/UT Tax

30

245,500

CESS

20

30

20

30

30

Top

Top

Top




@ DSC is compulsory for companies and LLP.

BACK

Site best viewed at 1024 x 768 resolution in Internet Explorer 10+, Google Chrome 49+, Firefox 45+ and Safari 6+

A confirmation message is displayed. Click OK to continue.

Message

You are utilizing Cash of Rs 180000 and ITC of Rs 91000 for payment of your
liability as selected by you. Once utilized, amount cannot be reversed. Do you

want to proceed?

26. Click the FILE WITH DSC or FILE WITH EVC button




Dashboard | Submit Application @ English

GSTIN/Temporary ID/UIN Legal Name Trade Name
07FBXPS5061N2Z1 Bhogaovalli shailaja Trade
Warning

Digital signatures are governed by the provisions of Information Techneclogy Act, 2000 ("IT Act™) and rules made thereunder. It is 8 mode of authenticating
electronic records [Section 2({p) of IT Act]. Affixing digital signature on any document herein is deemed to be equivalent to affixing hand written
signature/mark on such information/document (Section 5 of IT Act). Fraudulently/Dishonestly making use of any other person’s digital signature is a
punishable offence under IT Act (Section 66 C). Before attaching your digital signature certificate, please be certain that you wish to authenticate this

electronic record.
@ DSC is compulsory for Companies & LLP

@ Facing problem using DSC? Click here for help

SUBMIT WITH DsSC SUBMIT WITH EVC

26.1 FILE WITH DSC:
a. Select the certificate and click the SIGN button.

26.2 FILE WITH EVC:
a. Enter the OTP sent on the e-mail and mobile phone number of the Authorized Signatory registered at the GST Portal, and click the VALIDATE OTP button.




OTP Verification

Please enter OTP

OTP has been sent to your Email and Mobile number registered at the GST
portal

CLOSE VALIDATE OTP

27. The success message is displayed. ARN is generated and displayed. SMS and email will be sent to the taxpayer intimating ARN and successful filing of the Form.
Note:

= To download the submitted application, click the Click here link.

= You can click the CREATE NEW APPLICATION button to create a new application for making payment.



Dashboard G5T Law Downloads - Search Taxpayer - Help - e-Way Bill System New Return (Trial} -

Dashboard - My Applications - Acknowledgement

GSTIN/UIN/Temp Id - Legal Name - Bhogovalli shailaja Trade Name - Trade Status - Pending for Action by Tax
D7FBXPS5061MN2721 Officer

"Your ARN has been generated with ARN ADO71019000111X dated 25/10/2019". To download the Application Click here

<< CREATE NEW APPLICATION




Manual > Applying for Deferred Payment/Payment in Instalments (FORM
GST DRC-20)

How can I file an application for deferred payment or payment in instalments of amount due under the GST Act and follow
it up on the subsequent proceedings?

To file an application for deferred payment or payment in instalments of amount due under the GST Act and follow it up on the subsequent proceedings, perform following steps:
A. File an Application for deferred payment or payment in instalments

B. Open the Application's Case Details screen by searching for your filed Application in My Applications page or from View Additional Notices/Orders page

C. Take action using APPLICATIONS tab of Case Details screen: View your Filed Application

D. Take action using ORDERS tab of Case Details screen: View the Order issued on that Application

E. View Instalment Calendar

Click each hyperlink above to know more.

A. File an Application for Deferred Payment or Payment in Instalments

To file an Application for Rectification of Order, perform following steps:

1. Access the www.gst.gov.in URL. The GST Home page is displayed.
2. Login to the portal with valid credentials.
3. Dashboard page is displayed. Click Dashboard > Services > User Services > My Applications


https://tutorial.gst.gov.in/userguide/taxpayersdashboard/index.htm#t=manual_my_applications.htm
https://tutorial.gst.gov.in/userguide/taxpayersdashboard/index.htm#t=manual_additional_notice_and_order.htm
http://www.gst.gov.in/

Skip to Main Content Q A*Y A

Goods and Services Tax & PRAVINBHAL KALIDAS -
Dashboard GST Law Search Taxpayer - Help - e-Way Bill System
Registraticn Ledgers Returns Payments User Services Refunds
My Saved Applications My Applications
View/Download Certificates View Notices and Orders
WView My Submissions Contacts
Search HSN / Service Classification Code Holiday List
Feedback Grievance / Complaints
Generate User Id for Advance Ruling Furnish Letter of Undertaking (LUT)

View My Submitted LUTs Locate GST Practitioner (GSTP)
Engage / Disengage GST Practitioner (GSTP) ITCO2-Pending for action
View Additional Notices/Orders

4. My Applications page is displayed. In the Application Type field, select "Application for Deferred Payment/Payment in Instalments" and then click the NEW APPLICATION

button.



Dashboard = Services - User Services | My Applications|

My Applications

® indicates mandatory fizlds

Application Type* From Date To Date
Select v DD/MM/YYYY s DD/ MM/YYYY =
Select

Advance Ruling
Intimation of Veluntary Payment - DRC-03 SEARCH NEW APPLICATION

Letter Of Undertaking

Appeal to Appellate Authority

Application for rectification of order

Application for Restoration of Provisional Attachment

Application for Deferred Payment/Payment in Instalments
REFUNDS

5. New Application page is displayed. Enter details in the displayed fields as mentioned in the following steps.

Dashboard © Services © User Services - My Applications |New Application |

Application Type GSTIN/Temporary ID Legal Name of the Status
Application for Deferred 18AJIPA1572EAZB Applicant New Application
Pavment{’Payment in Instalments ANGAD JASBIRSINGH ARORA

® indicates mandatory fields

Payment Details*

Demand ID*

Enter Demand ID




Tax Period*

From To

Type Of Payment*

® | Monthly Instalments Deferred Payment

Monthly Instalments

Number of Months*

Select

Details of Application for Deferred Payment / Payment in Instalments

Upload Supporting Documents

Enter Document Description @ Only PDF/IPEG file format is allowed
@ Maximum file size for uplead is SMB
Choose File |Na file chosen

& Maximum 4 supporting documents can be
attached in the application. The remaining
documents can be handed over in hard copy.




Reasons

Enter Reason @ Reason can be given for more clarification

1000 characters remaining

Verification*

I, ANGAD JASBIRSINGH ARORA, hereby solemnly affirm and declare that the information given herein above is true and correct to the best of my
knowledge and belief and nothing has been concealed therefrom.

Mame of Authorized Signatory/ Applicant® Place®
Select v Enter Place
Designation / Status Date
21/08/2018

BACK PREVIEW SUBMIT




Note: Alternatively, you can access this application form from the following navigation: Dashboard > Services > Payments > Application for Deferred Payment/Payment in

Instalments

Dashboard Services - G5T Law Search Taxpayer - Help - e-Way Bill System

Registraticn Ledgers Returns User Services Refunds

Create Challan Saved Challans

Challan History Application for Deferred Payment/Payment in Instalments

5a. In the Demand ID field, enter the demand id and click the SEARCH button. Details of the outstanding demand against the Demand ID gets displayed below the SEARCH field.
Also, Tax Period fields below get auto-populated.



* indicates mandatory fields

Payment Details®

Demand ID*

£A180818000051W SEARCH

Description Integrated Tax () Central Tax (%) State / UT Tax () CESS (%)
Tax/Cess (F) 0 0 98,797 0
Interest (F) 0 0 0 0
Penalty () 0 0 10,000 0
Fees (F) 0 0 0 0
Others (F) 0 1] 0 1]
Total(F) 0 0 1,08,797 0

Tax Period®
From To
Apr 2018 Jul 20138

5b. In Type of Payment field, choose one of the two radio buttons against Monthly Instalments or Deferred Payment options.



Type Of Payment*®

® | Monthly Instalments Deferred Payment

5b. i. If you select the radio button against the Monthly Instalments option, its field appears. Enter the number of months and click the CALCULATE button. This will auto-
calculate and display the Expected Monthly Instalment table. Also, note the message below the expected monthly instalment table that mentions the per annum interest rate
which will be charged on the Tax/Cess amount.



Type Of Payment®
® Monthly Instalments Deferred Payment

hMonthly Instalments

Mumber of Months*®

10 CALCULATE

Description Integrated Tax (%) Central Tax (T) State / UT Tax () CESS (T)
Tax/Cess (F) 0 0 %,880 0
Interest (F) 0 0 0 ]
Exxpected Monthly Penalty (F) 0 0 1,000 0
Instalment Fees (3) 0 0 0 0
Others (F) 0 0 0 0
Total(%) 0 0 10,880 0

Mote: 18% interest rate per annum will be charged on the Tax/Cess Amount

Note: Maximum no of Installment allowed is 24.

5b. ii. If you select the radio buttons against the Deferred Payment option, its field appears. Select your preferred Due date of payment from the calendar.



Monthly Instalments (@ Deferred Payment

Deferred Payment

Due date of payment*®

DD/ MM/YYYY A

5c. In the Enter Document Description field, enter brief description of the document, if any, you wish to upload along with this application. Then, click Choose File to upload
those document(s). This is not a mandatory field.

Upload Supporting Documents

Enter Document Description © Only PDF/IPEG file format is allowed

Choose File |No file chosen

© Maximum file size for upload is SMB

O Maximum 4 supperting documents can be
attached in the application. The remaining
documents can be handed over in hard copy.

5d. In the Reasons field, if required, enter details about why you are filing this application. This is not a mandatory field.




Reasons

Enter Reason © Reason can be given for more clarification

1000 characters remaining

5e. Enter Verification details. The Date field is auto-populated based on the current system date. Select the declaration check-box and the name of the authorized signatory.
Based on your selection, the field Designation/Status displayed below gets auto-populated. Enter the name of the place from where you are filing this application.

Verification®

I, ANGAD ARORA, hereby solemnly affirm and declare that the information given herein abowve is true and correct to the best of my knowledge and
belief and nothing has been concealed therefrom.

Mame of Authonzed Signatory/ Applicant® Place®

ANGAD ARORA 1lrI Delhi I
Designation / Status Date
Manager 15/11/2018

BACK PREVIEW SUBMIT

5e. Click PREVIEW to download and review your application.



FORM GST DRC - 20
[See rule 158(1)]

Application for Deferred Payment/Payment in Instalments

1. Mame of the texable person - ANGAD JASBIRSINGH ARORA

2. GETIN/Temporary 1D - TBAJIPATSTZEATE
3 ARN -
4. Period - Apr 2018 to Jul 2018

In accordance with the provisions of section B0 of the Act, | request you to allow me extension of
timee wpte Mot Appliceble for payment of tex/’ other dues or to allow me to pay such tax/other dues
in 10 instalments for reesons stated below:

Demand ID [ ZA1B081E000051W

Description Cemtral tax { ) State/UT tax [ ) Iniegrated tax [ F) CESS ()
Tax/Cess a G857 i ]
Interest a a ] ]
Penalty a 10,000 ] ]
Fees ia a ] ]
Others a a o 0
Total ] 1,08 757 ] ]
Reason - Mot able fo pay the cument amount due to cash iss ues

Uploaded Supporting Documents - MA
Verification

| hereby solemnly affirm and declare that the information given herein above is true and comect to
the best of my knowledge and belief and nothing has been concealed therefrom.

Signature of Authorized Signatory

Name - ANGAD ARORA
Place - Delhi

Date - 1511/2018

5f. Once you are satisfied, click SUBMIT.



Warning

Are you sure vou want to submit the application?

CAMCEL PROCEED

6. Submit Application page is displayed. Click ISSUE WITH DSC or ISSUE WITH EVC.




Dashboard - Submit Application & English

APPLICATION TYPE LEGAL NAME GSTIN/UIN/Temporary ID

Application for Deferred Payment or Payment in ANGAD JASBIRSINGH ARDRA 18AJIPALS72EAZE
Instalments

Warning

Digital signatures are governed by the provisions of Information Technology Act, 2000 ("IT Act™) and rules made thereunder. It is @ mode of authenticating
electronic records [Section 2(p) of IT Act]. Affixing digital signature on any document herein is deemed to be equivalent to affixing hand written
signature/mark on such information/document {Section 5 of IT Act). Fraudulently/Dishonestly making use of any other person’s digital signature is a
punishable offence under IT Act (Section 55 C). Before attaching your digital signature certificate, please be certain that yvou wish to authenticate this

electronic record.
& D5C is compulsory for Companies & LLP

& Facing problem using DSC? Click here for help

FILE WITH D5C FILE WITH EVC

7. Provisional Acknowledgement page is displayed. You will also receive an SMS and email intimating you of the generated ARN and successful filing of the application. To
download the filed application, click the DOWNLOAD button or click Go To My Applications link go back to My Applications page.




Dashboard © Services  User Services © Provisional Acknowledgement

@Your form has been signed successfully through EVC

IGl:u To My Applications

Acknowledgement for submission of FORM GST DRC-20-Application for Deferred Payment/Payment in Instalments

Your application has been successfully submitted against AD1811180000515.

GSTIMN/Temporary ID 18AIIPALIST72EAZB

Date of filing 15/11/2018

Time of filing 14:04

Place of filing Delhi

Legal Name of the Applicant ANGAD JASBIRSINGH ARORA
Mame of the person who is filing the application ANGAD ARORA

It is a system generated acknowledgement and does not require any signature.

DOWNLOAD

Note: Once the application is filed, Status of the application gets updated to "Pending for Processing".
8. Additionally, following actions will take place on the GST Portal:
= Your application for payment in Installments will be submitted to the Commissioner of concerned jurisdictional authority and will become a pending item in his/her queue of

work-items. The Officer will adjudicate on the application and either Approve or Reject your request. You can access the generated ARN and view the filed application from the
following navigation: Dashboard > Services > User Services > My Applications > Case Details > APPLICATIONS

= Demand ID in DCR, in respect of which you have filed this application, will be flagged to show that such an application is filed against the Demand ID.

Go back to the Main Menu




C. Take action using APPLICATIONS tab of Case Details screen: View your Filed Application

To view Application Details based on which this Case was created, perform following steps:

1. On the Case Details page of that particular application, select the APPLICATIONS tab, if it is not selected by default. This tab provides you an option to view the filed
application, along with its supporting documents in PDF mode. Click BACK to go back to My Applications page.

Dashboard Services - User Services - My Applications © Case Details

ARN GSTIN/UIN/Temporary ID Date Of Application/Case Creation Status
AD1811180000515 18AJIPA1S572EAZB 15/11/2018 Pending for Processing
oo e T

ORDERS Application for Deferred Payment/Payment in Instalments G5T DRC-20

BACK

2. Click the documents in the "Action" column to download and view them.
3. Click BACK to go back to My Applications page.

Go back to the Main Menu

D. Take action using ORDERS tab of Case Details screen: View the Order Issued on that Application

To view and download the order issued against your application, perform following steps:

1. On the Case Details page of that particular taxpayer, click the ORDERS tab. This tab provides you an option to view the issued order, with all its attached documents, in PDF
mode.



Dashboard = Services - User Services - My Applications © Case Details

ARN GSTIN/UIN/Temporary ID Date Of Application/Case Creation Status
AD1511180000515 18AJIPA1572EAZB 15/11/2018 Approved

APPLICATIONS Order Number Type of Order Order Date Issued By
m ZA1811150001137 Approval Order 15/11/2018 First Test Name View

BACK

Click BACK to go back to My Applications page.
2. Click the View hyperlink in the "Action" column to download and view the issued Order.

Note 1:
= Status of this ARN/Case is "Rejected" as the Officer has rejected this application request.

= Status of ARN shall get updated to "Approved" in case of acceptance and “Application approved with modification” in case of modification.
Note 2:
Once the officer has processed an application for deferred/payment in Instalments, following actions will take place on the GST Portal:

= Approval or Rejection or Modification order will be generated and intimation of issue of order shall be sent via email and SMS to taxpayer.
= Status of ARN shall get updated to ‘Rejected’ in case of rejection, "Approved" in case of acceptance and “Application approved with modification” in case of modification.
= Order will be available at the dashboard of taxpayer for view, print and download: Dashboard > Services > User Services > My Applications > Case Details > ORDERS

= Status of Recovery ID remains the same in case of rejection. In case of acceptance or modification, the status of recovery ID shall change to “Deferred Payment/Payment by

Instalments”. If there is a default in the payment of monthly instalments, the status of recovery ID shall change from Deferred Payment/Payment by Instalments to Recoverable

Go back to the Main Menu




E. View Instalment Calendar

Instalment table displays the taxpayer's instalment details to be paid by him along with status of payments.

To view the instalment calendar, perform following steps:

1. Access the www.gst.gov.in URL. The GST Home page is displayed.
2. Login to the portal with valid credentials.

3. Dashboard page is displayed. Click Services > Payments > Instalment Calendar.

Dashboard Services = GST Law Search Taxpayer ~ Help - e-Way Bill System

Registration Ledoers Returns Payments User Services

Create Challan

Challan History

Instalment Calendar

Fefunds

Saved Challans

application for Deferred Payment/Payment in Instalments

4. The Instalment Calendar search page is displayed.
5. Enter the Demand ID.
6. Click the SUBMIT button.


http://www.gst.gov.in/

Dashboard = Instalment Calendar @ English

GSTIN/TEMP 1ID: Legal Name: Trade Name:
18AJIPA1S72EAZB ANGAD JASBIRSINGH ARORA Angad Provision

* indicates mandatory Fialds

Instalment Calendar®

Demand ID*

I ZA180818000051W I SUBMIT

7. The Instalment Calendar page is displayed.

Dashboard SErvices = GST Law Search Taxpayer = Help = e-Way Bill System
Dashboard  Instalment Calendar @ Enal
GSTIN/TEMP 1ID: Legal Name: Trade Name:
18AJIPA1S572EAZB ANGAD JASBIRSINGH ARORA Angad Provision
Demand ID: ZA130813000051W Date of Application: 15 November 2018 Payment Start Month: November 2018
Mumber of Instalments: 10 Payment Status: Lctive
Demand Outstanding Balance as per Order




10

Integrated Tax ()

Integrated Tax ()

Month
Movember 2018
December 2018
January 2019
February 2019
March 2019
April 2019
May 2015
June 2019
July 2019

August 2019

Note: Payments done after 'Date of Application' will be considered towards Instalment Amount.

Central Tax () State / UT Tax (%) CESS (T)
0 1,08,797 0
Expected Monthly Instalment
Central Tax () State / UT Tax (%) CESS (T)
0 10,880 0
Instalment Calendar
Integrated Tax (%) Central Tax (%) State / UT Tax (%) CESS () Total (¥)
0 0 10,880 o 10,880
0 0 10,880 o 10,880
] 0 10,880 o 10,880
0 0 10,879 0 10,879
o 0 10,880 O 10,880
0 0 10,880 o 10,880
o 0 10,879 o 10,879
0 0 10,880 o 10,880
0 0 10,880 o 10,880
0 0 10,879 o 10,879

Total ()

1,08,797

Total ()

10,880

Status
Pending
Expected
Expected
Expected
Expected
Expected
Expected
Expected
Expected

Expected

BACK




8. Click the major head hyperlink to view minor head details.

Dashboard - Instalment Calendar

Expected Monthly Instalment

GSTIN/TEMP 1D: Legal Name:

18AJIPALISTZ2EAZB ANGAD JASBIRSINGH ARORA
Demand ID: ZA18058183000051W Date of Application: 15 November 2018
Mumber of Instalments: 10 Payment Status: Active

Trade Name:

Angad Provision

Payment Start Month: November 2018

Demand Outstanding Balance as per Order

Integrated Tax (%) Central Tax (%) State / UT Tax (%)

I 1,08,797

Integrated Tax (%) Central Tax (%) State / UT Tax (%)

10,880

CESS (%)

CESS (%)

@ Englizh
Total (T)
0 1,08,797
Total (T)
0 10,880

9. The details are displayed.
10. Click the Close button.



State / UT Tax () :

Tax (%) Interest (T) Penalty (%) Fee (%) Other (%) Total (%)

98,797 a 10,000 a a 1,08,797

Go back to the Main Menu




Manual > Filing reply to Form GST DRC-22, against proceedings initiated for
Recovery of Taxes

The Tax Official has issued Form GST DRC-22, to the concerned authorities for provisional attachment of my property,
bank accounts, etc . How can I file reply to Form GST DRC-22 against proceedings initiated against me?

To file reply to Form GST DRC-22 against proceedings initiated against you by Tax Officer, for recovery of taxes by attaching your property, perform following steps:

A. Navigate to View Additional Notices/Orders page to view Notices and Orders issued against you by Tax Official
B. Take action using RECOVERY DETAILS tab of Case Details screen: View Recovery Details

C. Take action using NOTICES tab of Case Details screen: View issued Notices

D. Take action using REPLIES tab of Case Details screen: View/Add your reply to the issued Notice

E. Take action using CERTIFICATES/ ORDERS tab of Case Details screen: View issued Order or Certificate

Click each hyperlink above to know more.

B. Take action usingRECOVERY DETAILS tab of Case Details screen: View Recovery Details
To view the recovery details, perform following steps:

1. Navigate to Services > User Services > View Additional Notices/Orders option.


https://tutorial.gst.gov.in/userguide/taxpayersdashboard/index.htm#t=manual_additional_notice_and_order.htm

Dashboard Services = GST Law Search Taxpayer = Help - e-Way Bill System

Registration Ledgers Returns Payments User Services Refunds

My Saved Applications My Applications

View/Download Certificates View Motices and Orders

Yiew My Submissions Contacts

Search HSN / Service Classification Code Holiday List

Cause List Feedback

Grievance / Complaints Generate User Id for Advance Ruling

Furnish Letter of Undertaking (LUT) View My Submitted LUTs

Locate GST Practitioner (GSTP) Engage / Disengage G5T Practitioner (GSTF)
ITCO2-Pending for action I View Additional Motices/Qrders I

2. Click View.



Dashboard - Additional Motices and Orders
Type of Motice/ Order Description Ref ID Date of Issuance Action
RECOVERY Motice izsued for Recovery Id ID2410130004530 ZA2410180001756 24/10/2018 View
RECOVERY Motice issued for Recovery Id ID2410180004530 Z82410180001665 24/10/2018 View
RECOVERY Motice issued for Recovery Id ID2409130000003 ZA2410180000378 04/10/2018 View
RECOVERY Motice izssued for Recovery Id ID2409180000003 ZA241018000003] 01/10/2018 View
RECOVERY Motice issued for Recovery Id ID2409130000001 £A8241013000002L 01/10/2018 View
RECOVERY Motice izsued for Recovery Id ID2409180000001 Z82409130001338M 27/09/2018 View
Prosecution Motice issued against Prosecution Procesdings vide Reference Mumber ZA240918000114X% 26/09/2018 View
RECOVERY Motice izsued for Recovery Id ID2409180000004 ZA2409180000830U 26/00/2018 View
RECOVERY Motice issued for Recovery Id ID2409180000004 £A8240918000082W 26/09/2018 View
RECOVERY Motice izsued for Recovery Id ID2409130000001 ZA2409130000540U 24/00/2018 View
2[3]* 10 25 50 100

3. On the Case Details page of that particular taxpayer, select the RECOVERY DETAILS tab, if it is not selected by default. This tab displays all the details of demand issued and
mode of recovery.



Dashboard = Services  User Services - My Applications = Case Details
ARN GSTIN/UIN/Temporary 1D Date Of Application/Case Creation Status
ID2410180004530 24ABCPMEL47P126 03/10/2018 Recoverable
RECOVERY Demand Details
DETAILS D ol 1D Total Amount as per Demand | Amount Recovered as on Date | Recoverable Amount as on Date
() () )
MOTICES
ZA240913000152X 56,000 56,000
REPLIES
MOR Details
CERTIFICATES /
ORDERS Amou
Reference e . Date of
—— Mode of Recovery Recovered via Transadt
MORs (T)
ZA2410180001758 Attachment/Seizure of 0 24/10/2018
Immovable/Movable Properties by Tax ngress
Authorities
ZAZ2410180001665 Sale of Taxable Goods in control of 0 24/10/2018 In
Recovery Officer Progress

Go back to the Main Menu

C. Take action usingNOTICES tab of Case Details screen: View issued Notices

To view issued notices by the Tax Official, perform following steps:

1. On the Case Details page of that particular taxpayer, select the NOTICES tab, if it is not selected by default. This tab displays all the notices issued by the Tax Official.
2. Click the View link in the Action column of the table to download notices issued into your machine and view them.



Dashboard = Services - User Services © My Applications © Case Details
ARN GSTIN/UIN/Temporary 1D Date Of Application/Case Creation Status
ID2410180004530 24ABCPME147P126 03/10/2018 Recoverable

RECOVERY Motice Reference Number Mode of Recovery Notice Type m
DETAILS

ZA2410180001756 Attachment/Seizure of FORM G5T DRC - 22 (Provisional 24/10/2018 | View
NOTICES Immavghlefh‘lwable N Attachment of Property under Section

Properties by Tax Authonties  83)

REPLIES , , , ,

ZA2410180001665 Sale of Taxable Goods in FORM GST DRC — 10 (Motice for Auction  24/10/2018  View
CERTIFICATES / control of Recovery Officer zfﬂgmds under Section 79 (1) (b) of the
ORDERS

Go back to the Main Menu

REPLIES tab of Case Details screen: View/Add your reply to the issued NoticeD. Take action using

To view or add your reply to the to Form GST DRC-22, perform following steps:

1. On the Case Details page of that particular taxpayer, select the REPLIES tab. This tab will display the replies you will file against the Notices issued by the Tax Official. To add a
reply, click ADD REPLY.



ARM
ID2410180004530

ADD REPLY

RECOVERY
DETAILS

MOTICES

REPLIES

CERTIFICATES [/
ORDERS

Dashboard = Services = User Services © My Applications = Case Details

GSTIN/UIN/Temporary ID
24ABCPMB147P126

Date Of spplication/Case Creation
03/10/2018

Mo Records Found

Status
Recoverable

Mode of Recovery MNotice Type MNotice Reference Number Date of Reply Supporting Documents

2. The REPLY page is displayed.

ARN
ID2410180004530

RECOVERY
DETAILS

MOTICES

REPLIES

CERTIFICATES /
ORDERS

Select

Dashboard = Services  User Services © My Applications © Case Details

GSTIN/UIN/Temporary 1D
24ABCPMEB147P176

Maode of Recovery®

Motice Type®

Motice Reference Number®

Upload Reply*®

Date Of Application/Case Creation
03/10/2018

Attachment/Seizure of Immovable/Movable Properties by Tax ¥

FORM GST DRC — 16 (Motice for Attachment and Sale of Imr ¥

Status
Recoverable

* indicates mandatory fields




|Enter Document Description

Mo file chosen

€ Only PDF file format is allowed

& Maximum file size for upload is
SMB.

Upload Supporting Documents

|Enter Document Description

Mo file chosen

@ Only POF file format 1= allowed

6 Maximum file size for upload is 5
MB per document.

€ Maximum 4 supporting documents
can be attached in the application.
The remaining documents can be
handed over in hard copy.

Verification®

I, hereby solemnly affirm and declare that the information given herein above is true and correct to the best of my
knowledge and belief and nothing has been concealed therefrom.

Mame of Authorized Signatory Applicant® Flace*
Select r Enter Place
Designation ¢ Status Date
24/10/2018

BACK SUBMIT

3. Select the Mode of Recovery, Notice Type and Notice Reference Number from the drop-down list.



4. Click Choose File to upload your reply and upload any supporting document(s) related to your reply, if any.
5. Select the Verification check-box and select the name of the authorized signatory.

6. Enter the Place where the form is filed.

7. Click SUBMIT.

Dashboard  Services « User Services - My Applications = Case Details

ARN GSTIN/UIN/Temporary 1D Date Of Application/Case Creation Status
ID2410180004530 24ABCPMEB147P126 03/10/2018 Recoverable
RECOVERY
* indicates mandatory fields
DETAILS Mode of Recovery ®
MOTICES Attachment/Seizure of Immovable/Movable Properties by Ta: ¥
REPLIES
Motice Type®
CERTIFICATES /
ORDERS FORM G5T DRC - 16 (Notice for Attachment and Sale of Imr ¥

Motice Reference Number®

£424101800017356 ¥

Upload Reply*®

IEr'ter Document Description I

Mo file chosen

@ Only POF file format is allowed

6 Maximum file size for upload is
SMB.

Upload Supporting Documents

|Er'te r Document Description

Choose File | Mo file chosen




6 Only POF file format is allowed

6 Maximum file size for upload is 5
MB per document.

& Maximum 4 supporting documents
can be attached in the application.
The remaining documents can be
handed over in hard copy.

Verification®

I, ANGAD ARDRA, hereby solemnly affirm and declare that the information given herein above is true and correct to
the best of my knowledge and belief and nothing has been concealed therefrom.

Mame of Authonzed Signatory/ Applicant® Flace®
ANGAD ARORA v Enter Place

Designation / Status Date

CEOQ 24/10/2018

BACE SUBMIT

8. Click PROCEED.

Warning

Are you sure you want to submit?

CANCEL PROCEED




9. Submit Application page is displayed. Click ISSUE WITH DSC or ISSUE WITH EVC.

Dashboard  Submit Application @ English
TRADE NAME LEGAL NAME GSTIN/UIN/Temporary ID
SUN LIGHT(Paldi) PRAVINEHAI KALIDAS MISTRY 24ABCPME147P126

Warning

Digital signatures are governed by the provisions of Information Technology Act, 2000 ("IT Act™) and rules made thereunder. It 15 a mode of authenticating
electronic records [Section 2{p) of IT Act]. Affixing digital signature on any document herein is deemed to be equivalent to affbang hand wntten
signature/mark on such information/document (Section 5 of IT Act). Fraudulently/Dishonestly making use of any other person’s digital signature is a
punishable offence under IT Act (Section 66 C). Before attaching yvour digital signature certificate, please be certain that vou wish to authenticate this

electronic record.
6 D5C is compulsory for Companies & LLP

€ Facing problem using DSC? Click here for help

SUBMIT WITH DSC SUBMIT WITH EvC

10. A success message is displayed with the generated Reference number. Click OK.

Dashboard  Services - User Services - Provisional Acknowledgement

& Reply submitted successfully with Reference Id ZA2410180001772




11. The updated REPLIES tab is displayed, with the record of the filed reply in a table. You can also click the documents in the Action section of the table to download them.

Dashboard  Services - User Services -~ My Applications = Case Details
ARN GSTIN/UIN/Temporary ID Date Of Application/Case Creation Status
ID2410180004530 24ABCPMB8147P126 03/10/2018 Recoverable
RECOVERY ADD REPLY
DETAILS
Reply Reference . Notice Reference Date of
MNOTICES Mode of Recovery Notice Type
—— 7A2410180001772 Attachment/Seizure FORM GST DRC - 16  ZA2410180001756 24/10/2018 Reply
, of (Motice for
CERTIFICATES / Immovable/Movable  Attachment and Sale
ORDERS Properties by Tax of
Authorities Immovable/Movable
Goods/Shares under
Section 79)

Note: Once you file your reply successfully, following actions take place on the GST Portal:

¢ You will receive an acknowledgement intimation via your registered email and SMS, along with the generated RFN.

¢ Your reply will be available on Tax Official's dashboard.

Go back to the Main Menu

CERTIFICATES!/ E. Take action usingORDERS tab of Case Details screen: View Order Issued against Your Case

To download order issued against your case, perform following steps:

1. On the Case Details page of that particular taxpayer, click the CERTIFICATES / ORDERS tab. This tab provides you an option to view the issued order or certificate, with all its
attached documents, in PDF mode.

2. Click the View link in the Action column of the table to download and view them.



ARN
ID2410180004530

RECOVERY
DETAILS

NOTICES

REPLIES

CERTIFICATES /f

ORDERS

Dashboard - Services - User Services

My Applications -~ Case Details

GSTIN/UIN/Temporary ID
24ABCPME147P1726

Certificate / Order

Reference Number

FZAZA410180001780 Attachment/Seizure of
Immovable/Movable

Properties by Tax Authonbies

Date OFf Application/Case Creation

03/10/2018

FORM GST DRC - 12 (Sale Certificate))

Skatus
Recoverable

Issued on

24/10/2018

Go back to the Main Menu




Manual > Viewing Pre-GST Demand Uploaded by Tax Official (Form GST
DRC-07A & Form GST DRC-08A)

How can | view pre-GST demand uploaded by Tax Official?

To view pre-GST demand (Form GST DRC-07A & Form GST DRC-08A) uploaded by Tax Official, perform following steps:

1. Access the www.gst.gov.in URL. The GST Home page is displayed. Login to the portal with valid credentials. Click Dashboard > Services > User Services > View Additional

Notices/Orders.

Dashboard Services - GST Law Downloads - Search Taxpayer - Help ~ e-Way Bill System Mew Return (Trial} ~
Registration Ledgers Returns Payments User Services Refunds

My Saved Applications My Applications

View/Download Certificates View Motices and Orders

View My Submissions Search HSM / Service Classification Code

Holiday List Cause List

Feadback Furnish Letter of Undertaking (LUT)

View My Submitted LUTs Locate GST Practitioner (GSTP)

Engage / Disengage GST Practitioner (GSTF) ITCO2-Pending for action

WView Additional Motices/Crders

2. Additional Notices and Orders page is displayed. All orders/notices are displayed in descending order of date. You can search for the orders/notices you want to view using
the Navigation buttons provided. Click the View hyperlink to go to the Case Details screen of the issued Notice/Order.


http://www.gst.gov.in/

Dashboard = Services  User Services - Additional Notices and Orders

Type of Motice/Order Description Ref ID Date of Issuance Action

Pre-G5ST Recovery Intimation upon issuance of DRC-07A ZD0707200000924 03/07/2020 View

3. Case Details page is displayed. In that page, select the DRC-07A tab, if it is not selected by default. This tab displays the Form GST DRC-07A issued by Tax Official. Click
the hyperlink/s in the Documents section of the table to download and view them.

Dazhboard - Services - User Services - My Applications - Case Details

ARN GSTIN/UIN/Temporary 1D Date Of Application/Case Creation Status
ADOFOF200000121 O07FBXPS5061N221 07/07 /2020 DRC-07A issued
DRC-07A Order Number Date of Order Type of Order Issued By m
DRC-08A ZDO707200000924 08/07/2020 DRC-74 (Summary of W Deeksha Sindhur, FORM G5T
the order creating Commissioner DRC-7A

demand under
existing Laws)

Order Copy

4. Order copy is displayed in PDF format.

FORM GST DRC-7A

[See e 1424 (1))
Summary of the order creating demand under existing laws

Reference No. ZDO707 20000049V Date: D7,/07,/2020

Ta
07FBXPS5061N2ZI
Bhogovalii shailaja

Part A - Basic details

Sr. Description Particulars:
Mo,

m (2] (3)




1. GETINAUIMNS Temporary 1D DYFBXPSS061NIZI
2. |Legal name Bhogavalli shaitaja
3. | Trade name, if any Trade
4. | Government Autharity who passed the ardar
creating the demand State
5. Oid Registration Mo, O735ET65124
. Jurisdiction under earlier |aw 1, Dedhi, Ward 17
7. Act under which demand has been created | State VAT
8. Period faf which dernand has been ereated | From- JAN, 2014 Te- OCT, 2014
9. | Dnder Mo. [adiginal) Odr{2014)/73/1414
10. | Owder date (original) Z3/11/2004
11. | Latest arder no. Odr{201 73 12(ApI 1117
12 | Latest arder date o3 1207
13 | Date of service of the order (optional) o3/ 1002017
14. | Mame of the officer who has passed the Suresh Kumar
order {optional)
15. | Designation of the officer who has passed | Deputy Commissioner
the crder
16. | Stay status of the demand Ur-ztayed
17. | Date of stay arder -
1E. | Period af Stay -
Part B = Demand details
19. Details of dernand created
(Amount i Rs in all tables)
act Tax | Onterest | Penalty | Fee | Dthers | Total
1 z 3 4 5 i] 7
Central T T 0 0 m m
fcts
State/UT | TZ,78,995 734,570 35,798 0 m TIH0.363
Aty
CST Act T T 0 0 m m
20. Amaunt of demand paid under existing laws
A Tax Interest Pemalty Fee Others Tokal
1 2 ] 4q 3 [i] 7
Central Eut 1 0w 0 m 0
At
State/UT Eut 1 0w 0
Acts
CST Act T 0 0 0
. Balance amount of dermand proposed ta be recoversd under GET Laws
(19-20)
.5 Tax Interest Peralty Fee Others Tolal
1 z 3 4 5 i] 7
Central Eut 1 0w 0o m 0
fcts
State/UT | TZ,78,995 734,570 35,798 0 m T369.363
Acts
CST Act T T 0 L1 m m




Sigrature:
Hame: V Deeksha Sindhuri
Designation: Commissionss
Jurisdiction: 1

1. Oreles Copy

Note: The summary of pre-GST demand will be issued/uploaded in Form GST DRC-07A by Recovery officer on the GST Portal and the demand will be posted in Part Il of
Electronic Liability Register of the taxpayer. A sample screenshot is provided below.



Dashboard = Electronic Liability Ledger

Electronic Liability Register
From Date
08/07/2020

Stay status

Select

Date Reference Mo.

2 | 08/07/2020 ZDO707200000924

To Date

v

Tax Period, if
applicable

Jan 2014 to Oct
2014

O 08/07/2020 O

Ledger Relevant
used for Demand ID f
discharging Liability ID
liability
ZD0707200000924

0 English

Bhogovalli shailaja 07FBXPS5061N271

Demand Id/Reference No
ZDO707 200000524

Description

Opening Balance

Demand against summary of Order under pre-
55T Laws (DRC-074)

Closing Balance

5. Select the DRC-08A tab, if it is not selected by default. This tab displays the Form GST DRC-08A issued by Tax Official. Click the hyperlink/s in the Documents section of

the table to download and view them.



ARN GSTIN/UIN/Temporary 1D Date Of Application/Case Creation Status
ADOFOF200000121 O7FBXPS5061N221 07,/07 /2020 DRC-08BA issued

DRC-074 Order Number Date of Order Type of Order Issued By Documents
DRC-D8A ZDOT70720000055W 08/07/2020 DRC-8A WV Deeksha Sindhur, FORM G5T
(amendment/Modific Additional DRC-84

ation of summaw of Commissioner Order Copy

the order creating
demand under
existing Laws)

6. Order copy is displayed in PDF format.

FORM GST DRC-8A
[See rule 1424 (2]

Amendment/Modification of summary of the order creating demand under existing laws.
Reference No. ZDO707200000540 Drate: OB/O7/2020
Ta

O7FBXPS506T1MEZI
Bhogovalli =hailaja

Part A — Basic Details
Er Description Particulars
Ho.
(1 (2) jEl]

1. | GETIN/UIM/Tempaorary 1D O7FEXPSS061N2ZI
2 Legal name Bhogovalli shailaja
3. | Trade name, if any Trade
4. Reference no. vide which demand uploaded | ZDOTOT200000924

in Farm GST DRC-07A
5 Date of GST DRC-OTA vide which demand 08,07/ 2020

uploaded
6. | Government Authority who passed the order

creating the demand State
7. | 0ld Registration Mo. 07358765124
8 Jurigdiction under earlier law 1, Delhi, Ward 17
9. Actunder which demand has been created | State VAT
10. | Period for which demand has been created | From- JAN, 2014 To- OCT, 2014
11. | Order Mo. (original) Odr(2014)/73/1414
12. | Order Date (original) 23204
1% |l atact Firdar bin FlArl A TV AR 117



e[ e s w e e v g g e
14. | Latest Order Date 0310/2m?7
15. | Date of service of the order 03/10/2007
16. | Mame of the officer who has passed the Suresh Kumar
onder
17. | Designation of the officer who has passed | Deputy Commissioner
the onder
18. | Stey status of the demand Un-stayed
19. | Date of stay order -
20. | Period of Stay
1. | Reason for updation
Part B - Demand Details
(Amount in Re. in all tables)
22 Details of demand posted originally through table 21 of GST DRC-07 A (A)
Act Tax Interest Penalty Fee Others Total
1 2 3 4 5 B 7
Central i #0 # #0 #H #0
hcts
State/UT | F278905 | #34,570 255798 #0 # #3,69,363
hcts
C5T Act 0 #0 #) #0 #H 0
23 Updation of Demand (B)
At Type of Tax Interest Penalty Fee Others Total
updation
1 2 3 4 5 & 7 8
Central - 1] 20 #0 W #) 0
Acts
State/UT - #,73005 | #¥24,570 45,708 L4 1] #) #2,49,363
Acts
CST Act - #0 0 #0 # #H #0
{25‘23} Balance amount of demand required to be recovered under GET Laws (A - B)
Mt Tax Interest Penalty Fee Others Tatal
1 2 3 4 5 B 7
Central 20 #0 0 #0 #H Li1]
hcts
State/UT | #1,00000 ( #10,000 10,000 #0 # #1,20,000
hcts
CET Act i) #0 #) #0 #H #0

Note -Copy of the order wide which demand has been created can be attached. Documents in
support of tax peyment can also be uploaded, if available.

Signature:
Mame: W Deeksha Sindhurni
Designation:  Additional
Commissioner
Jurisdiction: 1




Note: The summary of pre-GST demand will be issued/uploaded in Form GST DRC-08A by Recovery officer on the GST Portal and the demand will be posted in Part Il of

Electronic Liability Register of the taxpayer. A sample screenshot is provided below.

Bhogovalli shailaja 07FBXPS5061N2~71T

Electronic Liability Register

From Date To Date Demand Id/Reference No

08/07/2020 i3] 08/07/2020 BB Enter a Demand Id/Reference Mo

Stay status
Sr. Date Reference MNo. Tax Period, if Ledger Relevant Demand Description
Mo. applicable used for ID / Liability ID

discharging
liability
1 Opening Balance
Jan 2014 to Oct Demand against summary of Order under pre-
2 0B8/07/2020 zZpDO707200000924 ZDO707200000924
' 2014 GST Laws (DRC-074)
Jan 2014 to Oct Demand against Modification of summary of

3 08/07/2020  ZDO70720000096W 2014 ZD070720000096W  Order under pre-G5T Laws (DRC-084)

7. To make payment against the pre-GST demand issued by Tax Official, navigate to Services > Ledgers > Payment towards Demand option.

Click here to know more about Payments towards Demand option.


https://tutorial.gst.gov.in/userguide/ledgers/index.htm#t=UtilizingCashmanual.htm

Manual > Viewing Prosecution Notice Issued by Tax Officials

How can | view Prosecution Notice issued by Tax Officials against my case?
To view Prosecution Notice issued by Tax Officials against your case, perform the following steps:
1. Access the www.gst.gov.in URL. The GST Home page is displayed.

2. Login to the portal with valid credentials.
3. Dashboard page is displayed. Click Dashboard > Services > User Services > View Additional Notices/Orders

Skip to Main Content @& A*Y A

%’ﬁv Goods and Services Tax & ANGAD JASBIRSINGH A ~
Dashboard GST Law Search Taxpayer ~ Help ~ e-Way Bill System
Registration Ledgers Returns Payments User Services Refunds
My Saved Applications My Applications
View/Download Certificates View MNotices and Orders
View My Submissions Contacts
Search HSN / Service Classification Code Holiday List
Feedback Grievance / Complaints
Generate User Id for Advance Ruling Furnish Letter of Undertaking (LUT)

View My Submitted LUTs Locate GST Practitioner (GSTP)
Engage / Disengage GST Practitioner (GSTP) ITCO2-Pending for action
View Additional Notices/Orders



http://www.gst.gov.in/

4. Additional Notices and Orders page is displayed. Click the View hyperlink to go to the Case Details screen of the issued Notice/Order.

Note: All orders/notices are displayed in descending order. You can search for the orders/notices you want to view using the Navigation buttons provided below.

Dashboard |Add|‘tional Motices and Drdersl

Type of Notice/Order Description Ref ID Date of Issuance Action
Prosecution Natice issued against Prosecution Proceedings vide Reference Number ZA2411180000121 08/11/2018
Prosecution Motice issued against Prosecution Proceedings vide Reference Number ZAZ240918000114% 26/09/2018 View
RECOVERY Motice issued for Recovery Id ID2409180000004 ZA240918000083U 26/09/2018 View

2|3 10 25 50 100

5. Case Details page is displayed. The NOTICES tab is selected by default, where the table containing details of the Prosecution Notice is displayed. Click the document name(s)
in the Documents section of the table to download into your machine and view them.



Dashboard - Services - User Services - My Applications - | Case Details

ARN GSTIN/UIN/Temporary ID Date Of Application/Case Creation Status
AD240918000016E 24ABCPMB8147P1706 27/09/2018 Complaint filed
MNOTICES
Reference/Notice No. Date of Notice Description of Motice Issued by Documents
ZA2411180000121 08/11/2018 test MUKESH Prosecutio
DHANIIBHAI n MNotice
KARSHALA
Commercial Tax
Officer

Note: Once the Tax Official has issued Notice against your case, Status will be "Complaint filed". It will get changed to "Closed" when the Tax Official closes the case in any of the

following cases:

= |f you file the application for compounding of offence and the same is allowed by the Commissioner and the compounding amount (tax, interest and penalty involved) is
also paid by you within the time specified in the Order, then the private complaint filed with the First Class Judicial Magistrate or Competent Court will be withdrawn/stand
abated. (for details refer Section 138)

= [f you file the application for compounding of offence and the same is allowed by the Commissioner and the compounding amount is paid by you within the time specified in
the Order, but the private complaint is not yet filed with the First Class Judicial Magistrate or Competent Court, then no further action shall be taken for prosecution in

respect of same offence.

= [f the private complaint filed with the First Class Judicial Magistrate or Competent Court is set aside, then the case stands closed.

= |f you have complied with the order of the First Class Judicial Magistrate or Competent Court, then the case stands closed.

Go back to the Main Menu




Manual > Filing Application for Compounding of Offence (Form GST CPD-01)
and Taking Actions in the Subsequent Proceedings

How can I file Application for Compounding of Offence (Form GST CPD-01) and take subsequent actions?

To file Application for Compounding of Offence (Form GST CPD-01) and take subsequent actions, perform following steps:

A. File an Application for Compounding_of Offence (Form GST CPD-01)

B. Open the Application's Case Details screen by searching for your filed Application in "My Applications" screen
C. Take action using APPLICATIONS tab of Case Details screen: View your Filed Application

D. Take action using NOTICES tab of Case Details screen:

D(1). View issued Notices

D(2). File Reply to the issued Notices

E. Take action using REPLIES tab of Case Details screen:
E(1) View Filed Replies

E(2) File Counter-replies

F. Take action using ORDERS tab of Case Details screen:
F(1). View the Order issued on that Application

F(2). Pay_ Compounding_ Fee
F(3). Initiate Rectification
G. Take action using RECTIFICATION tab of Case Details screen: View the filed Rectification Applications

Click each hyperlink above to know more.

A. File an Application for Compounding of Offence (Form GST CPD-01)

To file an Application for Compounding of Offence (Form GST CPD-01), perform following steps:

Note:
Any Taxpayer may file the Application for Compounding of Offence in the following two cases:

= Prosecution is instituted: This means that an Order for initiation of prosecution has been issued against the Taxpayer. He/she would have received a Prosecution Notice,

issued by a concerned Tax Official, regarding the same.



= Prosecution is contemplated: This means that the taxpayer is voluntarily filing this application for Compounding of Offence. A taxpayer can do so if he/she has received

an Order, issued by a concerned Tax Official, against any case involving commission of any offence specified in Section 132.

1. Access the www.gst.gov.in URL. The GST Home page is displayed.
2. Login to the portal with valid credentials.
3. Dashboard page is displayed. Click Dashboard > Services > User Services > My Applications

Skip to Main Content @ AY A

- Goods and Services Tax & PRAVINBHAL KALIDAS -
Dashboard GST Law Search Taxpayer ~ Help - e-Way Bill System
Registration Ledgers Returns Payments User Services Refunds
My Saved Applications My Applications
View/Download Certificates View Notices and Orders
View My Submissions Contacts
Search HSN / Service Classification Code Haoliday List
Feedback Grievance / Complaints
Generate User Id for Advance Ruling Furnish Letter of Undertaking (LUT)

View My Submitted LUTs Locate GST Practitioner (GSTP)
Engage / Disengage GST Practitioner (GSTP) ITCO2-Pending for action
View Additional Notices/Orders

4. My Applications page is displayed. In the Application Type field, select "Compounding Application" and then click the NEW APPLICATION button.


http://www.gst.gov.in/

Dashboard Services User Services My Applications

My Applications

® indicates mandatory fields

Application Type® From Date To Date
Select v DD/ MM/YYYY =2 DD/ MM/YYYY =
Select

Advance Ruling
Intimation of Voluntary Payment - DRC-03 SEARCH NEW APPLICATION

Letter Of Undertaking

Appeal to Appellate Authority

REFUNDS

Application for rectification of order

Application for Restoration of Provisional Attachment
Application for Deferred Payment/Payment in Instalments
Provisicnal Assessment ASMT-01

Compounding Application

5. Compounding Application page is displayed. The Yellow header on the top contains the name of the application type and your information—GSTIN, Legal Name and
Registration Status. Click the BACK button to go to the previous page or enter details in the displayed fields as mentioned in the following steps.

Dashboard - Services - User Services - My Applications - Compounding Application

Application Type GSTIN/Temporary ID/UIN Legal Name Status of the Applicant
Compounding of Offence 24ABCPMB147P126 PRAVINEHAI KALIDAS MISTRY Registered

FORM GST CPD-01

Application for Compounding of Offence

® indicates mandatory fields




Whether any order for initiation of prosecution has been issued? * @ Yes ON(:-

Prosecution Motice No. Date

B

Enter Prosecution Notice No. Dat

0]

Any other order against which prosecution is contemplated?

Order /Reference no. Date

2
a1}

=
fa]

Enter Order /Reference no.

The violation of provisions of the Act for which prosecution is instituted or contemplated: ®

(a) Supplies any goods or services or both without issue of any invoice, in violation of the provisions of this Act or the rules made thereunder,
With the intention to evade tax

(b) Issues any invoice or hill without supply of goods or services or both in violation of the provisions of this Act, or the rules made thereunder
leading to wrongful availment or utilisation of input tax credit or refund of tax

(c) Avails input tax credit using such invoice or bill referred to in clause (b) of Sub-Section (1) of Section 132

(d) Collects any amount as tax but fails to pay the same to the Gavernment beyond a period of three manths from the date on which such
payment becomes due

(e) Evades tax, fraudulently avails input tax credit or obtains refund by an offence not covered under clause (a) to (f) of sub-section (1) of
Section 132 of CGST/ UTGST/SGST Act

(f) Falsifies or substitutes financial recaords or produces fake accounts or documents or furnishes any false information with an intention to evade
payment of tax due under this Act

(@) Obstructs or prevents any officer in the discharge of his duties under this Act

(h) Acquires possession of, or in any way concerns himself in transporting, removing, depositing, keeping, concealing, supplying, or purchasing
or in any other manner deals with, any goods which he knows or has reason to believe are liable to confiscation under this Act or the rules made
thereunder

(i) Receives or is in any way concerned with the supply of, or in any other manner deals with any supply cf services which he knows or has
reason to believe are in contraventiocn of any provisions of this Act or the rules made thereunder

| | (i) Tampers with or destroys any material evidence or decuments




pelief, the burden of praving which shall be upon him, that the information supplied by him is true) supplies false information

(k) Fails to supply any infermation which he is required to supply under this Act or the rules made thereunder or {unless with a reasonable

(I} Attempts to commit, or abets the commission of, any of the offences menticned in clauses (a) to (k) of sub-secticn (1) of Section 132 of

CGST/ UTGST/SGST Act

Amount of evasion involved ®

Particulars Central Tax(%) State/UT Tax(%) Integrated Tax(X) Cess(X)
Tax 20 20 20 20 20
Interest 20 20 20 20 20
0
Penalty 20 20 20 20 20
Fine, if any 20 20 20 20 20
Others 20 20 20 20 20
. From To
Period of Offence =
DD/MM/YYYY o DD/MM/YYYY

Whether this is the first offence under the Act ® OYes

Whether any proceedings for the same offence is contemplated under any other law ® OYes ONG

Upload Supporting Documents, if any

ONo




Annexure for "Brief facts of the case and particulars of the offence (s)

@ File with PDF or JPEG format is
charged” can be uploaded along with other supporting document

only allowed

@ Maximum file size for upload is

5MB
Enter Document Description
O Maximum 4 documents can be
I‘Enter Description ‘I attached

© Click on "Add Document” button
to add the uploaded supporting
document

Declaration*

(1} I shall pay the compounding amount, as may be fixed by the Commissioner.

(2) T understand that I cannot claim, as a matter of right, that the offence committed by me under the Act shall be compounded.

Verification®

I I I son/daughter/wife Dfl I do hereby solemnly declare that to the best of my knowledge
and belief what is stated above and in the annexure(s), including the decuments are correct. I am making this application in my capacity as
(designation} and that I am competent to make this application and verify it.

Name of Authorized Signatory ® Place®
Select v Enter Place
Designation / Status Date




| BACK

5a. In the "Whether any order for initiation of prosecution has been issued?" field, select the "Yes" or "NO" radio button.

5a. (i) In case of "Yes" if any Order for initiation of prosecution has been issued: In the Prosecution Notice No. field, enter the Notice Number and click the SEARCH button. The
following fields get auto-populated: (Notice) "Date", "The violation of provisions of the Act for which prosecution is instituted or contemplated:", "Amount of evasion
involved,_ if any", "Period of Offence". Now, perform the Step 5e.

5a. (ii) In_ case of "No" if no Order for initiation of prosecution has been issued: In the "Any other order against which prosecution is contemplated?" field, enter the
Order/Reference Number and click the SEARCH button. (Order) Date gets auto-populated.
5b. In the "The violation of provisions of the Act for which prosecution is instituted or contemplated:" field, select the applicable radio button(s). You can select more than

one radio button.

5c. In the "Amount of evasion involved, if any" field, enter the amount across the respective major and minor heads.
5d. In the "Period of Offence" field, select the "From" and "To" dates using the calendar.

5e. In the "Whether this is the first offence under the Act" field, select the "Yes" or "NO" radio button.

5e. (i)._In case of "Yes" if this is the first offence under the Act: Perform the following_Step 5f.

5e. (ii).In case of "No" if this is not the first offence under the Act: Enter the relevant details in the text-box in maximum 250 characters. Then, perform the following step.

Whether this is the first offence under the Act ® Yes e No

5f. In the "Whether any proceedings for the same offence is contemplated under any other law" field, select the "Yes" or "NQO" radio button.



5f. (i)_In case of "Yes" if any _proceedings for the same offence is contemplated under any other law: Enter the relevant details in the text-box in maximum 250 characters. Then,

perform the following step.

Whether any proceedings for the same offence is contemplated under any other law ® ® Yes No

Please specify details of the proceedings

5f. (ii) In_case of "No"if no proceedings for the same offence is contemplated under any other law: Perform the following Step 5g.

5g. If required, in the Upload Supporting Documents, if any field, you can also upload supporting documents. This is not a mandatory field. Enter document description and click
the Choose File button. ADD DOCUMENT button gets displayed. Click it to upload the document(s) from your machine. You can delete the uploaded document by clicking the
DELETE button and upload again.



Enter Document Description

IMl:rre Details

ADD DOCUMENT

Enter Document Description

Enter Description

Choose File | No file chosen

p

Maore Details Additicnal Details.pdf

5h. In the Declaration field, select the two check-boxes.
5i. Enter Verification details. The "Designation/ Status" and "Date" fields is auto-populated based on the current system date.



Verification®

I ;&NGF&D JASBIRSINGH AR( son/daughter/wife of JASBIRSINGH AJAIBSING? da hereby solemnly declare that to the best of my knowledge
and belief what is stated above and in the annexure(s), including the documents are correct. I am making this application in my capacity as

E{:ED ' (designation) and that I am competent to make this application and verify it.
Name of Authorized Signatory® Place*
ANGAD ARORA v Surat
Designation / Status Date

CEO 18/01/2019

5j. Click PREVIEW to download and review your application. Once you are satisfied, click the PROCEED TO FILE button.

Form GST CPD - 01
[See rule 162710

Application for Compounding of Offence

1. BSTIN/ Temporary ID/UIN: 24ABCPME14TPIZE
2 Legal Name: PRAVINEHAI KALIDAS MISTRY
3. Address: .t &, Ahmedsbad, Gujarst, 251000

4. The violation of provisions of the Act for which prosecution is instituted or contemplated

{a) Supplies any goods or services or both without issue of any invoice, in violation of the provisions
of this Act or the rules mede thereunder, with the imtention to evads tax

(b} lssues any invoice or bill without supply of goods or services or both in violation of the provisions

of this Act, or the rules made thereunder leading to wrongful eveilment or vtilisation of input tax credit
or refund of tax

5. Detaits of adjudication order/notice:

- Reference Number: ZAZ2A01190000292
- Diate: 18/07/2019
- Period of (ffenca: Frome 07/09/2018 Too 01/12/2018

- Amount of evasion invohed, if any




Particulars Central State) UT Integrated Cess(7) Total(F)
TaxF) Tax(F) TaxF)

Tax F43,00,000 | F43500000 | F70,00000 0 F1,60,00,000
Interest #3,10,000 #8,10,000 F12.60,000 0 F28,80,000
Penalty F30,00,000 | F3000.000 ( F40,00.000 #0 #1,00,00,000

Fine, if any Eil] 0 F m 0
Others Eil] 0 Eill 0 i

Total: #2,88,60,000

. Brief facts of the case and particulars of the offence (s}  Refer Annexure
changed:

7. Whether this is the first offence under the Act: ‘ez

8. K answer 1o 7 is in the negative, the details of previous

Ca5es:

9. Whether any proceedings for the came offence is Ko
comemplated under any other law:

10, i anzwer to 9 is in the affimative, the details thereof:

e
1. More Compounding Details

Declaration;

[# (1) i shall pay the compounding amaunt, &= may be fed by the Commissionar.

1 {2 | understand that | cannot claim, as a matter of right, that the offence committed by me
under the Act shall be compounded.

Verification details -

I, ANGAD JASBIRSINGH ARDRA, son/dewghterfwife of JASBIRSINGH AJAIESINGH ARORA do
hereby solemnly declare that to the best of my knowledge and beliaf what is stated above and in
the annexura(s), including the documents are comect. | am making this application in my capacity
as CED (designation) and that | am competent to make this application and verify it

Hame of Authorized Signatory Place
ANGAD ARDRAJAJIPATITZE] Surat
Designation / Status Date

CEOQ 18/01/2019




5k. A Warning message is displayed. Click the PROCEED button.

Warning

You are about to submit application for Compounding of Offence (Form GST
CPD-01). Are you sure you want to proceed?

CANCEL ” PROCEED

6. Submit Application page is displayed. Click SUBMIT WITH DSC or SUBMIT WITH EVC.




Dashboard |Submit Application' @ English

GSTIN Legal Name Trade Name

18AJIPALS72EAZDB ANGAD JASBIRSINGH ARORA Angad Provision

Warning

Digital signatures are governed by the provisions of Information Technology Act, 2000 ("IT Act”) and rules made thereunder. It is a mode of authenticating
electronic records [Section 2({p) of IT Act]. Affixing digital signature on any document herein is deemed to be equivalent to affixing hand written
signature/mark on such information/document (Section 5 of IT Act). Fraudulently/Dishonestly making use of any other person’s digital signature is a
punishable offence under IT Act (Section 66 C). Before attaching your digital signature certificate, please be certain that you wish to authenticate this

electronic record.
@ DSC is compulsory for Companies & LLP
& Facing problem using DSC? Click here for help

SUBMIT WITH DSC SUBMIT WITH EVC

7. Acknowledgement page is displayed. To download the filed application, click the DOWNLOAD button or click Go To My Applications link go back to My Applications page.




Application Type GSTIN/Temporary ID/UIN Legal Name Status of the Applicant

Compounding of Offence 24ABCPMB147P1Z6 PRAVINBHAI KALIDAS MISTRY Registered

| Go To My Applications|

Acknowledgment of submission of Application for Compounding of Offence

You have filed the application successfully and the particulars of the application are given as under:

Application Reference Number (ARN) AD240119000015U
GSTIN/UIN/Temporary ID of the Taxpayer Z4ABCPMB147P1Z6

Name of the Taxpayer PRAVINBHAI KALIDAS MISTRY

Date of filing 18/01/2019

Form No. G5T CPD-01

Form Description Application for Compounding of Offence

It is a system generated acknowledgement and does not require any signature.

DOWNLOAD

Note:

Once the application is filed, following actions take place on the GST Portal:
= Status of the application on the GST Portal gets updated to "Compounding Application Submitted".
= You will also receive an intimation on your registered Mobile and email informing you of the generated ARN and successful filing of the application.

= The Application will land in the concerned authority's queue and he/she will take subsequent actions on it.



Go back to the Main Menu

B. Searching for your filed Application in "My Applications™ Screen

To search for the submitted applications and open the related ARN on the GST Portal, perform following steps:

1. Access the www.gst.gov.in URL. The GST Home page is displayed.
2. Login to the portal with valid credentials.
3. Dashboard page is displayed. Click Dashboard > Services > User Services > My Applications

Skip to Main Content & A*Y A

& PRAVINBHAI KALIDAS ~

Goods and Services Tax

Dashboard GST Law Search Taxpayer ~ Help - e-Way Bill System

Registration Ledgers Returns Payments User Services Refunds

My Saved Applications My Applicaticns

View/Download Certificates View Notices and Orders

View My Submissions Contacts

Search HSN / Service Classification Code
Feedback

Generate User Id for Advance Ruling

View My Submitted LUTs

Engage / Disengage GST Practitioner (GSTP)

View Additional Notices/Orders

Holiday List

Grievance / Complaints

Furnish Letter of Undertaking (LUT)
Locate GST Practitioner (GSTP)

ITCO2-Pending for action



http://www.gst.gov.in/

4. My Applications page is displayed. In the Application Type field, select "Compounding Application" from the drop-down list. Also select the submission period in the From
Date field and To Date field and then click SEARCH.

Dashboard - Services - User Services - My Applications

My Applications

*® indicates mandatory fizlds

Application Type* From Date To Date

Select T DD/MM/ Y = DD/MM/YYYY 2

Advance Ruling
Intimation of Voluntary Payment - DRC-03 SEARCH NEW APPLICATION

Letter Of Undertaking

Appeal to Appellate Authority

REFUNDS

Application for rectification of order

Application for Restoration of Provisional Attachment
Application for Deferred Payment/Payment in Instalments
Provisional Assessment ASMT-01

Compounding Application

5. Based on your Search criteria, applications are displayed. Click the ARN/RFN hyperlink you want to open.



Dashboard = Services = User Services - My Applications

My Applications

® indicates mandatory fields

Application Type* From Date To Date

Compeounding Application v 18/01/2019 ] 18/01/2019 i3

SEARCH NEW APPLICATION

ARN/RFN Form No. Form Description - Date of Filing - Status -

AD240119000015U GST CPD-01 Compounding 18/01/2019 Compounding Application Submitted

10 25 50 100

6. Case Details page is displayed. From this page, you can click on the tabs provided at the left-hand side of the page to view and download their related details.



Dashboard Services User Services © My Applications  |Case Details

ARMN GSTIN/UIN/Temporary ID Date Of Application/Case Creation Status
AD240119000015U 24ABCPMB8147P176 18/01/2019 Compounding Application
Submitted
APPLICATIONS Type of Documents View Documents
NOTICES Compounding of Offence View
REPLIES More Compeounding Details View
ORDERS
RECTIFICATION

Go back to the Main Menu

C. Take action using APPLICATIONS tab of Case Details screen: View your Filed Application

To view your filed Application Details, perform following steps:

1. On the Case Details page of that particular application, select the APPLICATIONS tab, if it is not selected by default. This tab provides you an option to view the filed
application, along with its supporting documents in PDF mode.



Dashboard = Services User Services My Applications « |Case Details

ARM GSTIN/UIN/Temporary ID Date Of Application/Case Creation Status
AD240119000015U 24ABCPMB147P176 18/01/2019 Compounding Application
Submitted
APPLICATIONS Type of Documents View Documents
NOTICES Compounding of Offence View
REPLIES More Compounding Details View
ORDERS
RECTIFICATION

2. In the "View Documents column, click the "View" hyperlink to download and view the related document.

Go back to the Main Menu

D(1). Take action using NOTICES tab of Case Details screen: View Issued Notices

To view the Notices issued by the concerned Tax Official to you against your Application for Compounding of Offence, perform following steps:

1. On the Case Details page of that particular application, select the NOTICES tab, if it is not selected by default. This tab displays all the notices (Hearing Notice/Adjournment)
issued by the concerned Tax Official to you.



Dashboard + Services = User Services . My Applications | Case Details
ARN GSTIN/UIN/Temporary ID Date Of Application/Case Creation Status
AD240119000015U 24ABCPMB147P176 i8/01/2019 Reply submitted
APPLICATIONS
Hearing
NOTICES
Notice No Type of Notice Date Place Issued On Issued By Documents
REPLIES _ ) _ _
; ZAZ240119000032F Adjournment 20/01/2019 Gujarat 18/01/2019 MUKESH Compounding Notice
ORDERS DHAMNIIBHAI
KARSHALA,
Commercial
RECTIFICATION
Tax Officer
ZA240119000031H Hearing 19/01/2019 | Gujarat 18/01/2019 MUKESH Compounding Notice
DHANIIBHAI
KARSHALA,
Commercial
Tax Officer

2. In the "Documents" column, click the document name(s) to download them into your machine and view them.

Go back to the Main Menu

D(2). Take action using NOTICES tab of Case Details screen: File Reply to the Issued Notice

To file reply to the Notices issued by the concerned Tax Official to you against your Application for Compounding of Offence, perform following steps:

1. On the Case Details page of that particular application, select the NOTICES tab, if it is not selected by default. This tab displays all the notices (Hearing Notice/Adjournment)

issued by the concerned Tax Official to you.



Dashboard « Services User Services . My Applications | Case Details

ARN GSTIN/UIN/ Temporary ID Date Of Application/Case Creation Status
AD240119000015U 24ABCPMB8147P1706 i8/01/2019 Reply submitted
APPLICATIONS
Hearing
NOTICES
Notice No Type of Notice Date Place Issued On Issued By Documents
REPLIES
ZA240119000032F Adjournment 20/01/2019  Gujarat 18/01/2019 MUKESH Compounding Notice
ORDERS DHANIIBHAI
KARSHALA,
Commercial
RECTIFICATION
Tax Officer
ZA240119000031H Hearing 19/01/2019 @ Gujarat 18/01/2019 MUKESH Compounding Notice
DHAMNIIBHAIL
KARSHALA,
Commercial
Tax Officer

2. Select the radio button against the Notice for which you want to file your reply. The REPLY button gets enabled. Click the enabled REPLY button.




Dashboard = Services User Services My Applications = Case Details
ARN GSTIN/UIN/ Temporary ID Date Of Application/Case Creation Status
AD240119000015U 24ABCPMB147P1706 18/01/2019 Reply submitted
APPLICATIONS
Hearing
NOTICES
Notice No Type of Notice Date Place Issued On Issued By Documents
REPLIES
ZA240119000032F Adjournment 20/01/2019 Gujarat  18/01/2019 MUKESH Compounding Notice
ORDERS DHANIJIBHAI
KARSHALA,
Commercial
RECTIFICATION
Tax Officer
ZA240119000031H Hearing 15/01/2019 Gujarat 18/01/2019 MUKESH Compounding Notice
DHANIIBHAI
KARSHALA,
Commercial
Tax Officer
REPLY

3. The REPLY page is displayed. The following fields are auto-populated—Name of the respondent, Notice Reference No, Date of communication of Notice. Enter details

in the other fields as mentioned in the following steps. To go to the previous page, click BACK.

Dashboard - Services - User Services - My Applications - Case Details

ARN GSTIN/UIN/Temporary ID Date Of Application/Case Creation Status
AD240119000013Y 24ABCPM8B147P1706 16/01/2019 Reply submitted

ARM T/ ATTA AR,




AFFLLIVATLUND
REPLIES
ORDERS

RECTIFICATION

Name of the respondent:

PRAVINBHAL KALIDAS MISTRY
Notice Reference No:
ZA240119000011]
Details of Reply

Upload Reply to Notice: ®

Choose File ||Na file chosen

Upload Supporting Documents (if any)

Enter Document Description

Choose File Mo file chosen

Verification ®

|:|1

Date of communication of Notice:

16/01/2019

san/daughter/wife ofl

® indicates mandatory fields

O Only PDF file format is allowed

@ Maximum file size for upload is 5MB.

@ File with PDF or JPEG format is only
allowed.

O Maximum file size for upload is SMB.

O Maximum 4 documents can be
attached.

@ Click on "Add Document” button to
add the uploaded supporting document

|do hereby solemnly declare that to the best

of my knowledge and belief what is stated above and in the annexure(s), including the documents are correct. I am making

this application in my capacity as

and verify it.

Mame of Authorized Signatory®

Select v

(designation) and that T am competent to make this application

Place*

Enter Place




Designation / Status Date

BACK PROCEED

3a. In the Details of Reply field, click Choose File to upload the document(s) related to your reply.

3b. If required, in the Upload Supporting Documents, (if any) field, you can also upload supporting documents. This is not a mandatory field. Enter document description
and click the Choose File button. ADD DOCUMENT button gets displayed. Click it to upload the document(s) from your machine. You can delete the uploaded document by
clicking the DELETE button and upload again.

Enter Document Description

IMl:rre Details

ADD DOCUMENT

Enter Document Description

Enter Description

Choose File | No file chosen

~ o

More Details Additiocnal Details.pdf




3c. Enter Verification details. The "Designation/ Status" and "Date" fields is auto-populated based on the current system date.

Verification®

I ;;&NGAD JASBIRSINGH AR( son/daughter/wife of JASBIRSINGH AJAIBSINGZ da hereby solemnly declare that to the best of my knowledge
and belief what is stated above and in the annexure(s), including the documents are correct. I am making this application in my capacity as

E{:ED ' (designation) and that I am competent to make this application and verify it.
Name of Authorized Signatory® Place*
ANGAD ARORA v Surat
Designation / Status Date
CEO 18/01/2019

3d. Click the PROCEED button.
3e. A warning popup is displayed. Click the PROCEED button in the popup as well.



Warning

You are about to submit a Reply. Are you sure you want to proceed?

CANCEL H PROCEED

4. Submit Application page is displayed. Click SUBMIT WITH DSC or SUBMIT WITH EVC.




Dashboard |Submit Application' @ English

GSTIN Legal Name Trade Name

18AJIPALS72EAZDB ANGAD JASBIRSINGH ARORA Angad Provision

Warning

Digital signatures are governed by the provisions of Information Technology Act, 2000 ("IT Act”) and rules made thereunder. It is a mode of authenticating
electronic records [Section 2({p) of IT Act]. Affixing digital signature on any document herein is deemed to be equivalent to affixing hand written
signature/mark on such information/document (Section 5 of IT Act). Fraudulently/Dishonestly making use of any other person’s digital signature is a
punishable offence under IT Act (Section 66 C). Before attaching your digital signature certificate, please be certain that you wish to authenticate this

electronic record.
@ DSC is compulsory for Companies & LLP
& Facing problem using DSC? Click here for help

SUBMIT WITH D5C SUBMIT WITH EVC

5. Acknowledgement page is displayed with the generated Reply Reference number. Click the OK button.



Dashboard = Services User Services My Applications = JAcknowledgement

Your reply has been filed against Notice No. ZA2401190000351H dated 18/01/2019. Your Reply Reference No. ileA24E}11900ﬂ034B|dated
18/01/2019

OK

6. The updated REPLIES tab is displayed, with the record of the filed reply in a table. Click the documents in the Documents section of the table to download them.

Dashboard = Services  User Services = My Applications  Case Details
ARN GSTIN/UIN/Temporary ID Date Of Application/Case Creation Status
AD240119000015U 24ABCPM8147P176 i8/01/20190 Reply submitted
APPLICATIONS
Reply Ref No. Notice No Filed by Date of Reply Documents

NOTICES

ZA240119000034B ZA240115000031H 24ABCPMEB147P1Z6, 18/01/2019 Compounding Reply
REPLIES PRAVINBHAI KALIDAS

MISTRY
ORDERS .
ZA240115000033D ZA240119000031H B24000000001301, 18/01/2019 Compounding Reply
Praveen Galande

RECTIFICATION

7. Once the Taxpayer files reply, following actions take place on the GST Portal:

= ARN Status on the GST Portal gets updated to "Reply submitted".

= All concerned Tax Officials will be intimated about the filed reply via their registered email.



= Dashboard of the Taxpayer is updated with the record of the filed reply. He/she can view it from the following navigation: Services > User Services > My Applications >
REPLIES.

= Dashboard of all the concerned Tax Official roles is updated with the record of the filed reply.

Go back to the Main Menu

E(1). Take action using REPLIES tab of Case Details screen: View Filed Replies

To view the replies filed by you or the concerned Tax Officials against your Application for Compounding of Offence, perform following steps:

1. On the Case Details page of that particular application, select the REPLIES tab. This tab will display the replies that you or the concerned Tax Officials have filed on the
issued Notices.

Dashboard © Services User Services © My Applications  |Case Details

ARM GSTIN/UIN/Temporary ID Date Of Application/Case Creation Status
AD240119000015U 24ABCPMB8147P1706 18/01/2019 Reply submitted
APPLICATIONS
Reply Ref No. Notice No Filed by Date of Reply Documents

NOTICES

o ZA240119000034B ZAZ240115000031H Z4ABCPMB147P126, 18/01/2019 IC’JmpDL;ndiﬂg Rep!vl
REPLIES PRAVINBHAI KALIDAS

MISTRY
ORDERS ; :
ZA2401159000033D ZA240115000031H B24000000001301, 18/01/2019 Compounding Reply
Praveen Galande

RECTIFICATION

2. In the "Documents" column, click the document name(s) to download them into your machine and view them.



Go back to the Main Menu

E(2). Take action using REPLIES tab of Case Details screen: File Counter-replies

To file counter- replies after a concerned Tax Official has filed reply against your Application for Compounding of Offence, perform following steps:

1. On the Case Details page of that particular application, select the REPLIES tab. This tab will display the replies that you or the concerned Tax Officials have filed on the
issued Notices. Select the radio button against the Reply for which you want to file your reply. The REPLY button gets enabled. Click the enabled REPLY button.

Dashboard Services User Services - My Applications = |[Case Details

ARN GSTIN/UIN/Temporary ID Date Of Application/Case Creation Status
AD240119000015U 24ABCPMB147P1706 18/01/2019 Reply submitted
APPLICATIONS
Reply Ref No. Notice No Filed by Date of Reply Documents
NOTICES
® ZA240119000033D ZA240115000031H B24000000001301, 18/01/2019 Compounding Reply
‘ REPLIES \ Praveen Galande
ORDERS

REPLY
RECTIFICATION

2. The REPLY page is displayed. Follow the steps you would have performed to file your reply to the issued Notices. Click here to revisit those steps.

Dashboard - Services © User Services - My Applications - Case Details

ARN GSTIN/UIN/Temporary ID Date Of Application/Case Creation Status

AD240119000015U 24ABCPME147P17Z6 18/01/2019 Reply submitted




APPLICATIONS
MNOTICES
ORDERS

RECTIFICATION

Name of the respondent:

PRAVINBHAI KALIDAS MISTRY

Motice Reference No:

ZA240115000031H

Details of Reply

Upload Reply to Notice: ®

Choose File

o file chosen

Upload Supporting Documents (if any)

Enter Document Description

Choose File | No file chosen

\erification ®

O 1

son/daughter/wife of

of my knowledge and belief what
this application in my capacity as

and verify it.

18/01/2019

Date of communication of Notice:

Name of Authorized Signatory ®

Select

*® indicates mandatory fields

@ Only PDF file format is allowed

@ Maximum file size for upload is 5MB.

@ File with PDF or JPEG format is only
allowed.

@ Maximum file size for upload is SMB.

O Maximum 4 documents can be
attached.

@ Click on "Add Document” button to
add the upleaded supporting document

do hereby solemnly declare that to the best

s stated above and in the annexure(s), including the documents are correct. I am making

(designaticn) and that I am competent to make this application

Place®

Enter Place




Designaticon / Status Date

BACK PROCEED

3. Once the Taxpayer files a counter-reply, following actions take place on the GST Portal:
= ARN Status on the GST Portal gets updated to "Reply submitted".

= All concerned Tax Officials will be intimated about the filed reply via their registered email.

= Dashboard of the Taxpayer is updated with the record of the filed reply. He/she can view it from the following navigation: Services > User Services > My Applications >
REPLIES.

= Dashboard of all the concerned Tax Official roles is updated with the record of the filed reply.

Go back to the Main Menu

F(1). Take action using ORDERS tab of Case Details screen: View the Order Issued on that Application

To view and download the order issued on your Application for Compounding of Offence, perform following steps:

1. On the Case Details page of that particular application, click the ORDERS tab. This tab provides you an option to view the issued order, with all its attached documents, in
PDF mode. The concerned authority may grant or reject compounding.



In Case the Commissioner grants Compounding:

Dashboard Services User Services

ARN
AD240119000015U

APPLICATIONS
NOTICES
REPLIES

‘ ORDERS \

RECTIFICATION

My Applications | Case Details

GSTIN/UIN/Temporary ID Date Of Application/Case Creation
24ABCPM8147P176 18/01/2019
Order Number Type of Order Passed on Passed by
ZA2401190000375 Order for allowance 158/01/2019 MUKESH

of compounding of DHAMNIIBHAIL

offence KARSHALA ,

Commercial Tax
Officer

PAY FEE

Status
Compounding allowed

Download

Compounding Order




In Case the Commissioner rejects Compounding:
Dashboard « Services  User Services My Applications Case Details
ARN GSTIN/UIN/Temporary ID Date Of Application/Case Creation Status
AD241218000026Q 24ABCPM8B147P176 20/12/2018 Compounding Rejected
APPLICATIONS Order Number Type of Order Passed on Passed by Download
MOTICES ) ZA241218000103D Order for Rejection of 20/12/2018 MUKESH Compounding Order
compounding of DHANIIBHAI
REPLIES offence KARSHALA ,
Commercial Tax
| ORDERS | Officer
RECTIFICATION

2. In the "Documents” column, click the document name(s) to download them into your machine and view them.
Note1:
Additionally, once the concerned authority issues an Order, following actions will take place on the GST Portal:

= Taxpayer and the concerned Tax Official will receive an intimation on their registered Mobile and email informing them of the issued Order.

= In case the concerned authority grants the application request: Status of the ARN willl get updated to "Compounding allowed".

= In case the concerned authority rejects the application request: Status of the ARN will get updated to "Compounding Rejected" and the following actions will take place:
o If the compliant has been filed with the Magistrate/Court of competent jurisdiction, no action will be taken and prosecution proceedings will continue.

o If no compliant has been filed with the Magistrate/Court of competent jurisdiction, the concerned Tax official will proceed with prosecution proceedings.

Note2:

The concerned authority may, as per his/her discretion, withdraw Compounding at any stage during the processing of the Compounding Application. If he/she chooses to do so,
the status of the ARN shall get updated to "Compounding Withdrawn" and thereafter, no action could be performed, by the Taxpayer or the concerned Tax Officials, on the



withdrawn Application.

Go back to the Main Menu

F(2). Take action using ORDERS tab of Case Details screen: Pay Compounding Fee
To pay compounding fee in order to avoid further proceedings against you by the department, perform following steps:

Note:

= You can pay Compounding Fee only when the concerned authority allows the application request by issuing "Compounding allowed" Order on your Application for
Compounding of Offence.

= You need to pay the Compounding fee within 30 days of the Order, else the Order will become void.

= You need to make payment of compounding fee through cash ledger only. ITC can be utilized for payment of tax only. Payment of taxes will be as per the rules applicable.

1. On the Case Details page of that particular application, click the ORDERS tab. Click the PAY FEE button below the table containing "Compounding allowed" Order.

Dashboard © Services . User Services My Applications | Case Details

ARN GSTIN/UIN/Temporary ID Date Of Application/Case Creation Status
AD240119000015U 24ABCPMB8147P1706 18/01/2019 Compounding allowed
APPLICATIONS Order Number Type of Order Passed on Passed by Download
MOTICES s ZAZ2401190000375 Order for allowance 18/01/2019 MUKESH Compounding Order
of compounding of DHANIIBHAI
REPLIES offence KARSHALA ,

Commercial Tax

ORDERS Officer
RECTIFICATION
PAY FEE




2. Payment FEE page gets displayed with the table containing the Fee applicable as per the Act and the difference of amount which is available in your Cash Ledger versus the
amount required in Cash Ledger to pay the applicable fee . If "Amount required in Cash Ledger" column is not "Nil", click the "DEPOSIT IN CASH LEDGER" button to generate a
challan and deposit money in the Electronic Cash Ledger. Otherwise, click the "UTILIZE CASH" button to make payment using the cash present in your Electronic Cash Ledger.



status

Compounding allowed

Dashboard - Services - User Services - My Applications - Case Details
ARN GSTIN/UIN/Temporary ID Date Of Application/Case Creation
AD240119000015U 24ABCPMB8147P176 18/01/2019
APPLICATIONS
NOTICES Order Reference No: ZA2401190000375 Date of Order: 18/01/201%9
REPLIES Payment of Compounding Fee:
ORDERS Fee Amount available in Cash Amount required in Cash
Applicable Ledger Ledger
RECTIFICATION Act (in %) (in T) (in )
(1) (2) (3) (4)
Central Tax 2250000 0.00 2250000.00
State/ UT 2250000 250000.00 2000000.00
Tax
Integrated 3500000 0.00 3500000.00
Tax
Cess 0 0.00 Nil
DEPOSIT IN CASH LEDGER UTILIZE CASH

1. If there is not
sufficient balance in
Cash Ledger (under
Fee head), i.e.
"Amount required in
Cash Ledger” is not
nil, then click on
Deposit in Cash
Ledger button to
deposit the required
amount, in Cash
Ledger.

2. If sufficient
balance is available in
Cash Ledger (under
Fee head), i.e
"Amount required in
Cash Ledger” is nil
for all the selected
acts, then click on
Utilize Cash button
to fill and utilize.

Note: On clicking the "DEPOSIT IN CASH LEDGER" button, the challan page will get displayed.

Click here to know how to generate challan and deposit cash in the cash ledger.



https://www.gst.gov.in/help/payments

3. On clicking the ""UTILIZE CASH" button, the Acknowledgement page gets displayed with the generated PRN. Click OK.

Dashboard - Services - User Services » My Applications |Acknowledgement|

Payment of compeounding fees of amount against your compounding application vide AD24011900001 dated18/01/2019 has been successfully
made using the "Utilize Cash"” option vide]PRN: IP0703190000061.]

OK

4. The updated Orders tab is displayed. Also, note that as you have now paid the compounding fee the "PAY FEE" button is disabled.

Dashboard = Services © User Services My Applications = Case Details

ARN GSTIN/UIN/Temporary ID Date Of Application/Case Creation Status
AD240119000015U 24ABCPMB147P1Z6 18/01/2019

Compounding Fee paid

APPLICATIONS Order Number Type of Order Passed on Passed by Download

NOTICES @ ZA2401190000375 Order for allowance 18/01/2019 MUKESH Compounding Order
of compounding of DHANIIBHAI

REPLIES offence KARSHALA |,

Commercial Tax

ORDERS Officer

RECTIFICATION

Note:

Once the Compounding Fee is paid, following actions take place on the GST Portal:

o Status of the ARN will get updated to "Compounding Fee paid".



« If the compliant has been filed with the Magistrate/Court of competent jurisdiction, the concerned Tax official will withdraw the complaint.

* If no compliant has been filed with the Magistrate/Court of competent jurisdiction, no prosecution proceedings willl be initiated.

Go back to the Main Menu

F(3). Take action using ORDERS tab of Case Details screen: Initiate Rectification

In case you notice an error apparent from the face of the order, you can file rectification application against the Compounding Order passed by the concerned authority.

Note:

= You can submit the Application for rectification within <three months> from the date of Order sought to be rectified.

= No rectification shall be allowed after a period of six months from the date of issue of such decision or Order and if the rectification is purely in the nature of correction of a

clerical or arithmetical error, the limitation of six months will not apply.
To initiate rectification, perform following steps:

1. On the Case Details page of that particular application, click the ORDERS tab. Select the radio button against the Order for which you want to initiate rectification. The
INITIATE RECTIFICATION button gets enabled. Click the enabled INITIATE RECTIFICATION button.



Dashboard  Services User Services © My Applications - Case Details

ARN GSTIN/UIN/Temporary ID Date Of Application/Case Creation Status
AD240119000015U 24ABCPM8B8147P176 ig/01/2019 Compounding allowed
APPLICATIONS Order Number Type of Order Passed on Passed by Download
NOTICES @ ZA2401190000375 Order for allowance 18/01/2019 MUKESH Compounding Order
of compounding of DHANIIBHAI
REPLIES offence KARSHALA .

Commercial Tax
ORDERS Officer
RECTIFICATION
PAY FEE INITIATE RECTIFICATION

2. "Submission of Rectification request" page is displayed. The following fields are auto-populated—Order Reference No & Date of communication of Order. Enter details in
the other fields as mentioned in the following steps.

Dashboard - Services - User Services - My Applications - Case Details

ARN GSTIN/UIN/Temporary ID Date Of Applicaticn/Case Creation Status
AD240119000015U 24ABCPM8B8147P1706 18/01/2019 Compounding allowed
APPLICATIONS Submission of Rectification request
NOTICES *® indicates mandatory fields
REPLIES Order Reference No: ZA2401190000375

ORDERS Date of communication of Order: 18/01/2019

RECTIFICATION Details of Rectification




Upload Rectification request: *

Choose File |[No file chosen

Upload supporting documents:

Enter description of the document ® File with PDF or JPEG
_ _ format is only allowed

O Maximum file size for

upload is GMB
Choose File |[No file chosen

© Maximum 4 documents
can be attached

O Click on “Add Document”
button to add the uplocaded
supporting document

Verification®

I son/daughter/wife ofl |do hereby solemnly declare that to the best
of my knowledge and belief what is stated above and in the annexure(s), including the documents are correct. I am making
this application in my capacity as (designation) and that I am competent to make this application
and verify it.

Mame of Authorized Signatory ® Place*

Select v Enter Place

Designation / Status Date

| PROCEED TO FILE |




| |

2a. In the Details of Rectification field, click Choose File to upload the document(s) containing details of the rectification that needs to be done.
2b. If required, in the Upload supporting documents field, you can also upload supporting documents. This is not a mandatory field. Enter document description and click the

Choose File button. ADD DOCUMENT button gets displayed. Click it to upload the document(s) from your machine. You can delete the uploaded document by clicking the
DELETE button and upload again.

Enter Document Description

IMl:rre Details

ADD DOCUMENT

Enter Document Description

Enter Description

Choose File | No file chosen

Maore Details Additicnal Details.pdf u

2c. Enter Verification details. The "Designation/ Status" and "Date" fields is auto-populated based on the current system date.



Verification®

I EANGAD JASBIRSINGH ARii son/daughter/wife of EJASBIR,SINGH AJAIBSINGI da hereby solemnly declare that to the best of my knowledge
and belief what is stated above and in the annexure(s), including the documents are correct. I am making this application in my capacity as

ECED ' (designation) and that I am competent to make this application and verify it.
Name of Authorized Signatory® Place*
ANGAD ARORA v Surat
Designation / Status Date
CEO 18/01/2019

2d. Click the PROCEED TO FILE button. A warning popup is displayed in case. Click PROCEED in the popup.



Warning

You are about to file the Rectification Application. Are you sure you want to
proceed?

CAMNCEL ‘ PROCEED

Note: In case the difference between the date of the Order and rectification application filed is more than 6 months, an information message shall pop up asking for confirmation
“Do you still want to file the Rectification application as the period exceeds 6 months from the date of the order”.

4. Submit Application page is displayed. Click SUBMIT WITH DSC or SUBMIT WITH EVC.



Dashboard |Submit Application' @ English

GSTIN Legal Name Trade Name

18AJIPALS72EAZDB ANGAD JASBIRSINGH ARORA Angad Provision

Warning

Digital signatures are governed by the provisions of Information Technology Act, 2000 ("IT Act”) and rules made thereunder. It is a mode of authenticating
electronic records [Section 2({p) of IT Act]. Affixing digital signature on any document herein is deemed to be equivalent to affixing hand written
signature/mark on such information/document (Section 5 of IT Act). Fraudulently/Dishonestly making use of any other person’s digital signature is a
punishable offence under IT Act (Section 66 C). Before attaching your digital signature certificate, please be certain that you wish to authenticate this

electronic record.
@ DSC is compulsory for Companies & LLP
& Facing problem using DSC? Click here for help

SUBMIT WITH D5C SUBMIT WITH EVC

5. Acknowledgement page is displayed with the generated Reference number. Click the OK button.



Dashboard © Services - User Services - My Applications |Ackn0w|edqement|

Your rectification application has been filed against Order No. ZA241218000050G dated 18/12/2018. Your Rectification of order Reference No. is
| ZA240119000042E]dated 22/01/2019.

6. The updated RECTIFICATION tab is displayed, with the record of the filed rectification application request in a table and the Status updated to "Rectification request
submitted". Click the documents in the Details of Rectification section of the table to download them.

Dashboard - Services - User Services - My Applications - Case Details
ARN/Case Id GSTIN/UIN/Temporary Id Date of Application/Case Creation Status
AD240119000015U 24ABCPME8147P176 18/01/2019 Rectification request submitted
APPLICATIONS Date of Reasons
Filing for
MOTICES Rectification No Order No Filed by Rectification Status Rejection Documents
REPLIES ZA2401190000383 ZA2401190000375 Praveen 22/01/2019 Rectification MA Compounding
Galande, request Rectification
ORDERS Commer submitted Document
cial Tax

Note:

Once a Rectification request is submitted by a Taxpayer, following actions take place on the GST Portal:

= Dashboard of Taxpayer and the concerned Tax Officials is updated with the record of the submitted Rectification request.



= Status of the ARN on the GST Portal gets updated to "Rectification request submitted".

Go back to the Main Menu

G. Take action using RECTIFICATION tab of Case Details screen: View the Filed Rectification Applications

To view the Rectification Applications filed by the Taxpayer or the concerned Tax Official, perform following steps:

1. On the Case Details page of that particular application, select the RECTIFICATION tab, if it is not selected by default. This tab displays all the rectification applications

submitted by you or the concerned Tax Officials.

Dashboard  Services = User Services © My Applications = |Case Details

ARM GSTIN/UIN/ Temporary ID Date Of Application/Case Creation Status
AD241218000028M 24ABCPM8147P1Z6 21/12/2018 Compounding Fee paid
APPLICATIONS Date of Reasons for Details of
Rectification No Order No Filing Filed by Rejection Rectification
NOTICES
ZA2412180001257 ZA2412180001182 21/12/2018 MUKESH MA Compounding
REPLIES KARSHALA[ACKP Rectification
K3463A] Document
ORDERS
ZAZ241218000120H  ZA2412180001182 21/12/2018 Praveen MNA Compounding
RECTIFICATION Galande, Rectification
Commercial Tax Document
Officer

2. In the "Details of Rectification" column, click the document name(s) to download them into your machine and view them.

Note:

Once a Rectification request is submitted by a Taxpayer, the concerned authority may either accept the request or reject it. However, in case the Order which need to be rectified
has the effect of enhancing the tax liability or reducing the amount of admissible input tax credit then, it cannot be passed unless the Applicant has been given an opportunity of




being heard.

In case of Acceptance:

= The concerned authority issues the Rectification Order. Dashboard of Taxpayer and the concerned Tax Officials is updated with the record of the issued Order. Taxpayer can
access the Rectification Order from the ORDERS tab.
= Status of the ARN on the GST Portal gets updated to "Rectification order passed".

In case of Rejection:

= The concerned authority issues the Order. Dashboard of Taxpayer and the concerned Tax Officials is updated with the record of the issued Order. Taxpayer can access the
Order from the RECTIFICATION tab.
= Status of the ARN on the GST Portal gets updated to "Rectification request rejected".

Go back to the Main Menu
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Demands and Recovery



Filing an Intimation of Payment
- Form GST DRC 03



Payment on Voluntary Basis (FORM GST DRC-03)

4 N

What is the facility for Payment on Voluntary Basis?

Payment on Voluntary Basis is a facility given to tax payers to make payment u/s 73 or 74 of the CGST Act,
2017 within 30 days of issuance of Show Cause Notice (SCN). Payment could also be made by taxpayers
before SCN is issued.

KWhen can | make voluntary payment? A
You can make voluntary payment before issue of notice u/s 73 or 74 of the CGST Act, 2017 or within 30 days of

issue of show cause notice (SCN) under the said sections. You cannot make voluntary payment after 30 days of
stue of SCN.

%
KWhat are the pre-conditions to make voluntary payment? \
The pre-conditions to make voluntary payment are:
a. In case, voluntary payment is made before issue of SCN
e Show Cause Notice under determination of tax should not have been issued.
b. In case, voluntary payment is made after issue of SCN or statement
\030 days’ time has not lapsed since SCN is issued. J




Payment on Voluntary Basis (FORM GST DRC-03)

How can | make voluntary payment?
To make voluntary payment against the liability (tax, interest & penalty) based on self-ascertainment of tax, navigate
to Services > User Services > My Applications > Intimation of Voluntary Payment - DRC - 03 option.

Can | make partial payment against a liability raised in a SCN?
GST Portal does not allow for making partial payments against a liability raised in a SCN. Complete payment of the
amount being demanded in SCN has to be made.

hen would a taxpayer need to select “Liability mismatch- GSTR-1 to GSTR-3B” and “ITC Mismatch- GSTR- \
2A/2B to GSTR-3B” as cause of payment while making payment under “Intimation of Voluntary Payment-DRC-
03”?
Taxpayer needs to select “Liability mismatch- GSTR-1 to GSTR-3B” as cause of payment, when there is a liability
mismatch between Form GSTR-1 and Form GSTR-3B and taxpayer is making payment of such liability using Form
DRC-03.
Taxpayer needs to select “ITC Mismatch- GSTR-2A/2B to GSTR-3B” as cause of payment, when there is ITC
mismatch between Form GSTR-2A/2B and Form GSTR-3B and taxpayer is making payment of such liability arising
using Form DRC-03.
These are additional reasons made available under Intimation of Voluntary Payment-DRC-03 for taxpayers for
making payments for liabilities noticed later on. The navigation to make such payment is Services > User
Services > My Application > Application Type > Select Intimation of Voluntary Payment-DRC -03, Click New
pplication > select Cause of Payment.




Payment on Voluntary Basis (FORM GST DRC-03)

/What will happen on filing of Form GST DRC-03? )
Electronic Liability Register, Electronic Cash Ledger and Electronic Credit Ledger will be updated upon filing of
Form GST DRC-03 i.e. Debit/Credit (both) entry will be posted simultaneously and PRN will be generated

@ccordingly. )

<

| don't have sufficient balance to make payment against a liability raised in a SCN. What do | do now?

You can deposit the amount in Electronic Cash Ledger through "Create Challan" functionality which is available on
voluntary payment screen. On click of "Create Challan" button, you will be redirected to Create Challan screen in
Payment module. In the Create challan page, challan amounts will be auto-populated based on the amount of
additional cash required considering the tax liabilities and others.

/
Can | save the application for intimation of voluntary payment? \
Application for intimation of voluntary payment can be saved at any stage of completion for a maximum time
period of 15 days. If the same is not filed within 15 days, the saved draft will be purged from the GST

database. To view your saved application, navigate to Services > User Services > My Saved

Applications option.

J




Applying for Deferred Payment
or Payment in Instalments
(FORM GST DRC - 20)



Applying for Deferred Payment or Payment in Instalments (FORM GST DRC - 20)

K\Nhat is the purpose of FORM GST DRC - 20?
FORM GST DRC - 20 is an application form that can be filed by any taxpayer to apply for one of the following
two options available to him in case he cannot pay the entire amount due under the GST Act in one go:
Deferred payment: when dues are deferred for payment at later stage

Qayment in instalments: when due is paid in installments over a period of time

~

fWhen can | file FORM GST DRC - 20?
You can file FORM GST DRC - 20 when a demand is pending for recovery under GST Act against you and you
wish to apply for deferred payment or payment in instalments of amount due under the GST Act.

Q(ou are required to have valid login credentials to file this application.

AN

Qan | file FORM GST DRC - 20 in respect of amount against return related demands?
No, application for deferred payment using FORM GST DRC - 20 cannot be filed against return related
demands. You can file application for deferred payment using FORM GST DRC - 20 for other than return
Qelated demands, which are posted in Electronic Liability Register Part-B.

AN

How many applications for deferred/payment in Instalments can | file?
Only one “Application for Payment in Instalments” can be submitted against a particular Demand ID.




Applying for Deferred Payment or Payment in Instalments (FORM GST DRC - 20)

~

In FORM GST DRC - 20, | need to enter the number of months for my instalments. Is there any limitation on

the number of months?
Yes. Maximum number of instalments allowed is 24.

N\ J

mow is the interest calculated if | select the option of "Monthly Instalments" in FORM GST DRC - 20? \
Interest is calculated considering the following points:

Interest will be applicable only on the tax/cess amount applied for instalment/deferment.

No interest will be payable on the Interest, Penalty and any other amount in the Demand ID.

Interest will not be calculated by system as part of application for deferred payment/payment in instalment.
Instead, if any interest needs to be recovered from taxpayer as part of monthly instalment then tax officer

will create separate demand ID which will be paid by taxpayer. J

What will happen if | am unable to make the required payment, after the acceptance of my application for
payment in Instalments?

In case there is any default in payment of any one installment on its due date, the whole outstanding balance
payable on such date will become due and payable forthwith, and will be liable for recovery without any
further notice to the Taxpayer.

\_ J




Applying for Deferred Payment or Payment in Instalments (FORM GST DRC - 20)

ﬁave filed FORM GST DRC - 20. What actions will take place on the GST Portal now? x
Once you have filed FORM GST DRC - 20, following actions will take place on the GST Portal:
GST Portal will generate and display Application Reference Number (ARN) receipt with an option to”Save and
Print” the same.
SMS and Email will be sent to you intimating ARN and successful filing of the Form.
Your application for payment in Installments shall be submitted to the Commissioner/proper officer of concerned
jurisdictional authority and will become a pending item in his/her queue of work-items. The Officer will
adjudicate on the application and either Accept or Reject or Accept with modification your request. You can
access the generated ARN and view the filed application from the following navigation: Dashboard > Services >
User Services > My Applications > Case Details > APPLICATIONS
Qmand ID in DCR, in respect of which you have filed this application, will be flagged to show that such an /
ap

plication is filed against the Demand ID.

What is an Instalment Calendar?
Instalment Calendar displays the taxpayer's instalment details to be paid by him along with status of payments.

From where | can view the Instalment Calendar?
Navigate to Services > Payments > Instalment Calendar to view the Instalment Calendar.




Applying for Deferred Payment or Payment in Instalments (FORM GST DRC - 20)

How will | come to know that the officer has processed my application for deferred/payment in \
Instalments?

Once the officer has processed an application for deferred/payment in Instalments, following actions will
take place on the GST Portal:

Approval or Rejection or Modification order will be generated and intimation of issue of order shall be sent
via email and SMS to taxpayer.

Status of ARN shall get updated to ‘Rejected’ in case of rejection, "Approved" in case of acceptance and
“Application approved with modification” in case of modification.

Order will be available at the dashboard of taxpayer for view, print and download:

Dashboard > Services > User Services > My Applications > Case Details > ORDERS

Status of Recovery ID remains the same in case of rejection. In case of acceptance or modification, the
status of recovery ID shall change to “Deferred Payment/Payment by Instalments”. If there is a default in
the payment of monthly instalments, the status of recovery ID shall change from Deferred

Payment/Payment by Instalments to Recoverable /




Applying for Deferred Payment or Payment in Instalments (FORM GST DRC - 20)

During the processing of applications for deferred payment or payment in instalments, what all and \

when the Status changes take place in an ARN/Case ID on the GST Portal?

On the GST Portal, during the processing of applications for deferred payment or payment in instalments,

the ARN/Case ID may undergo following Status changes:

* Pending for Processing: When a taxpayer files the application and it is under work item of tax officer

 Approved: When tax officer approves the application of taxpayer for deferred payment or payment in
instalments

* Application approved with modification: When tax officer approves the application with certain
modifications

* Rejected: When tax officer rejects the application of taxpayer for deferred payment or payment in

kinstalments

J




Filing reply against proceedings
initiated for Recovery of Taxes -
Form GST DRC-22



Filing reply to Form GST DRC-22, against proceedings initiated for Recovery of Taxes

When recovery process in GST Portal/ law is initiated? \

Recovery process in GST Portal is initiated under following conditions:

* Demand ID is created under Assessment, Enforcement, Appeal, Refund or any other module and is reflected in
the Electronic Liability Register.

* Prescribed time under the GST law for making the payment of adjudged dues has expired i.e., Recovery against
demand is not stayed by any competent authority,

« Demand is in recoverable stage, not within appeal period, finally adjudged, or appeal not filed against the

k order/appellate order ( i.e. order via which demand is confirmed). /
hat are the various modes of recovery process? \
In GST regime, where any sum is payable by the taxpayer on account of scrutiny, assessment, enforcement,

adjudication and appeal process, and remains unpaid, the tax authorities would initiate the recovery process by

adopting any of the following modes as provided in the GST laws. Some of the modes are -

v’ Detaining and selling of goods of the taxpayer in the possession of the tax department/ other officer

v" Issuance of letter / correspondence to third parties including banks / any other government departments/
debtors/ any other person provided in law/ successor or transferee or legal heir

v’ Distrain, detain and sell immovable and movable property

v’ Issuance of certificate to revenue authorities for recovery as arrears of Land Revenue

v’ Application to magistrate to recover as fine

K\/Recovery from Electronic Cash Ledger/ Electronic Credit Ledger of a taxpayer /
v

Any other mode as prescribed under law




Filing reply to Form GST DRC-22, against proceedings initiated for Recovery of Taxes

What type of notices can be issued?
Based on Mode of Recovery selected, relevant notice type can be issued. The table below provides the list of
notice types which can be issued based on mode of recovery.
Sale of taxable goods in control of FORM GST DRC - 10 (Notice for Auction of Goods under section 79
Recovery officer (1) (b) of the Act)

FORM GST DRC - 13 (Notice to a third person under section 79(1) (c))
Notice to Third Parties FORM GST DRC - 15 (Application before the Civil Court requesting

execution for a Decree)

FORM GST DRC - 16 (Notice for attachment and sale of
immovable/movable goods/shares under section 79)

FORM GST DRC - 22 (Provisional attachment of property under
section 83)

Attachment/Seizure of
Immovable/Movable properties by Tax
Authorities

Application to Magistrate for recovery | FORM GST DRC - 19 (Application to the Magistrate for Recovery as
as Fine Fine)

FORM GST DRC - 09 (Order for recovery through specified officer

under section 79)
S

Notice to Specified Officer




Filing reply to Form GST DRC-22, against proceedings initiated for Recovery of Taxes

What type of certificates/ orders can be issued?
Based on Mode of Recovery selected, relevant certificate/ order type can be issued. The table below provides
the list of certificate/ order type which can be issued based on mode of recovery.

Sale of Taxalgle Goods in control of FORM GST DRC - 12 (Sale Certificate)
Recovery officer

Notice to Third Parties FORM GST DRC - 14 (Certificate of Payment to a Third Person)

FORM GST DRC - 12 (Sale Certificate)
FORM GST DRC - 23 (Restoration of provisionally attached property /
bank account under section 83)

Attachment/Seizure of Immovable/
Movable properties by Tax Authorities

Issuance of Certificate to Revenue FORM GST DRC - 18 (Certificate action under clause (e) of sub-
Authorities section (1) section 79)

FORM GST DRC - 18 (Certificate action under clause (e) of sub-

Recovery from other state section (1) section 79)




Filing reply to Form GST DRC-22, against proceedings initiated for Recovery of Taxes

/Do | get any intimation about the notice or order issued?
Navigate to Services > User Services > View Additional Notices/ Orders to view any notification. You will not
receive any intimation through Email or SMS.

Y

From where can | view notice issued for recovery of taxes?
Navigate to Services > User Services > View Additional Notices/ Orders > View > NOTICES option.
NS

NS

From where can | reply to notice issued for recovery of taxes?
Navigate to Services > User Services > View Additional Notices/ Orders > View > REPLIES option.

From where can | view rejection order issued for recovery of taxes?
Navigate to Services > User Services > View Additional Notices/ Orders > View >CERTIFICATES/ ORDERS option.




Filing reply to Form GST DRC-22, against proceedings initiated for Recovery of Taxes

Do | get any intimation once a Tax Official utilizes the amount from my Electronic Credit/Cash Ledger to

make recovery of the taxes?
Intimation is sent to the taxpayer via SMS and E-mail once a Tax Official utilizes the amount from your

Electronic Credit/Cash Ledger to make recovery of the taxes.

What will happen once I file reply to Form GST DRC-22, against proceedings initiated for Recovery of Taxes ?
Once you file your reply successfully, following actions take place on the GST Portal:
You will receive an acknowledgement intimation via your registered email and SMS, along with the generated

RFN.
Your reply will be available on Tax Official's dashboard.

\_ J
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Viewing Pre-GST Demand Uploaded by Tax Official (Form GST DRC-07A & GST DRC-08A)

/What is Form GST DRC-07A? I
If any demand (Tax, interest, penalty, fees or any other dues) was created under Pre-GST laws (e.g. State VAT /
CST / Central Excise / Service Tax etc.) and is not recovered under those laws, then it can be recovered as
arrears of GST, under GST Act.

The summary of such pre-GST demand will be issued/uploaded in Form GST DRC-07A by Recovery officer on

Qhe GST Portal and the demand will be posted in Part Il of Electronic Liability Register of the taxpayer.

_/
/What is Form GST DRC-08A? \
Where a pre-GST demand order, uploaded via Form GST DRC-07A is rectified or modified or quashed in any
proceedings, including that in appeal, review or revision, or the recovery is made under the existing laws, a
summary of such order will be uploaded in FORM GST DRC-08A. Accordingly, Part Il of Electronic Liability
Qegister will also be updated. J

Where can | view Form GST DRC-07A issued to me?
To view Form GST DRC-07A, navigate to
Services > User Services > View Additional Notices and Orders > View > DRC-07A.

Where can | view Form GST DRC-08A issued to me?
To view Form GST DRC-08A, navigate to
Services > User Services > View Additional Notices and Orders > View > DRC-08A.




Viewing Pre-GST Demand Uploaded by Tax Official (Form GST DRC-07A & GST DRC-08A)

(Does a taxpayer get any intimation about Form GST DRC-07A or Form GST DRC-08A issued to him? )
Taxpayer will get intimation of issue of Form GST DRC-07A/ Form GST DRC-08A issued to him/her, though SMS
and e-mail.

NS J

/What are the various tabs available in case details page? A
Two clickable tabs - DRC-07A and DRC-08A are available in case detail page.

* DRC-07A: To view details of the DRC-07A issued by Tax Official

K. DRC-08A: To view details of the DRC-08A issued by Tax Official D,
How can | make payment against the pre-GST demand issued by Tax Official? )
To make payment against the pre-GST demand issued by Tax Official, navigate to Services > Ledgers > Payment
towards Demand option.

X P Y,

. ) ) ™
What are the various Status types for searching a pre-GST Recovery Case ID on the Search Screen?

KVarious status types of a pre-GST Recovery Case ID are: )

DRC-07A issued When Form GST DRC-07A is issued by Recovery Officer
DRC-08A issued When Form GST DRC-08A is issued by Recovery Officer
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Viewing Prosecution Notice
Issued by Tax Officials



Viewing Prosecution Notice Issued by Tax Officials

ﬁVhat are Prosecution Proceedings?

with varied quantum of punishments. Some of the offences are compoundable while some others are not.

GST law) for initiation of criminal proceedings, when the Tax official has reason to believe that any person
has committed any of the offences under provisions of GST law. (For details, refer Section 132 of the

@ST/SGST Act)

Prosecution Proceedings are instituted against the taxpayers who are involved in cases of tax evasion beyond
the specified limit and for which penal actions are applicable on specific events subject to certain conditions

Prosecution actions include filing of private complaint based on facts which constitute an offence (under the

\

mhat are the steps involved in Prosecution Proceedings?
Following steps are involved in Prosecution Proceedings:

the Taxpayer, with the First Class Judicial Magistrate/Court.

2.Tax Official issues the Prosecution Notice against the Taxpayer. Intimation of the issue of Notice is sent to
the concerned taxpayer on his/her registered email id and mobile. Dashboard of the Taxpayer is also
updated with the record of the issued Notice. He/she can view the issued Notice from the following
navigation: Services > User Services > View Additional Notices/Orders.

1.After taking due sanction from the Commissioner, the Tax Official files a Private Complaint (offline) against

/
~

_/




Viewing Prosecution Notice Issued by Tax Officials

n what cases, can a Prosecution Complaint against me be closed?

The Prosecution Complaint against you can be closed in the following cases:

* Ifyou file the application for compounding of offence and the same is allowed by the Commissioner and
the compounding amount (tax, interest and penalty involved) is also paid by you within the time
specified in the Order, then the private complaint filed with the First Class Judicial Magistrate or
Competent Court will be withdrawn/stand abated. (for details refer Section 138)

* If youfile the application for compounding of offence and the same is allowed by the Commissioner and
the compounding amount is paid by you within the time specified in the Order, but the private
complaint is not yet filed with the First Class Judicial Magistrate or Competent Court, then no further
action shall be taken for prosecution in respect of same offence.

e If the private complaint filed with the First Class Judicial Magistrate or Competent Court is set aside,
then the case stands closed.

!f you have complied with the order of the First Class Judicial Magistrate or Competent Court, then thy

case stands closed.

During Prosecution Proceedings, what all Status changes does the Case undergo? N
During Prosecution Proceedings, the Case undergoes following Status changes:
* Complaint filed: When details of prosecution complaint is uploaded by the Tax Official.

\.* Closed: When status of complaint is updated as closed by the Tax Official. )
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Filing Application for Compounding of Offence (Form GST CPD-01) and Taking Actions in
the Subsequent Proceedings

ﬁNhat is the purpose of Form GST CPD-01?

Form GST CPD-01 is Application for Compounding of Offence. Any Taxpayer can file this application in the

following two cases:

* Prosecution s instituted: This means that an Order for initiation of prosecution has been issued against
the Taxpayer. He/she would have received a Prosecution Notice, issued by a concerned Tax Official,
regarding the same.

* Prosecutionis contemplated: This means that the taxpayer is voluntarily filing this application for

\ Compounding of Offence. In this case, he/she might have received a Prosecution Notice or an Order,

issued by a concerned Tax Official.

hen can | file Form GST CPD-01-Application for Compounding of Offence? \

Any Taxpayer may file the Application for Compounding of Offence in the following two cases:
* Prosecution s instituted: This means that an Order for initiation of prosecution has been issued against

the Taxpayer. He/she would have received a Prosecution Notice, issued by a concerned Tax Official,

regarding the same.
* Prosecutionis contemplated: This means that the taxpayer is voluntarily filing this application for

Compounding of Offence. A taxpayer can do so if he/she has received an Order, issued by a concerned Tax
\ Official, against any case involving commission of any offence specified in Section 132. /




Filing Application for Compounding of Offence (Form GST CPD-01) and Taking Actions in
the Subsequent Proceedings

hat is the general process of conducting Compounding Proceedings on GST Portal?
General process of conducting Compounding Proceedings on GST Portal is:
1. The Taxpayer files Application for Compounding of Offence (Form GST CPD-01) on the GST Portal.
2.The concerned authority examines the Application for Compounding of Offence filed by the Taxpayer with
reference to the provisions and may issue Hearing Notice to the Prosecution and Compounding Officer or
Taxpayer or both before disposing the application.
3. The Taxpayer can file reply to the issued Notice or can appear on the day of the scheduled hearing.
4. On the date of hearing, party(ies) appear before the concerned authority. The concerned authority can also
issue an Adjournment Notice to the party(ies) with details of new date, new place and new time of hearing.
5.After conducting hearing and examining the application and the related documents received during hearing, if
any, the concerned authority will issue an Order either allowing or rejecting the application for Compounding.
6. The Taxpayer or the Prosecution and Compounding Officer may, if required, file for rectification of the issued
"Compounding allowed" Order.
7.If required, the concerned authority may also do a Suo-moto rectification of the issued "Compounding
allowed" Order. No rectification can be done after a period of six months from the date of issue of such decision
or order. However, if the rectification is purely in the nature of correction of a clerical or arithmetical error,
limitation of six months will not apply.
Note: The concerned authority may, as per his/her discretion, make a suo-moto withdrawal of the Compounding
plication at any stage, once it has been filed by the Taxpayer.




Filing Application for Compounding of Offence (Form GST CPD-01) and Taking Actions in
the Subsequent Proceedings

ﬁVhat happens on the GST Portal once the Form GST CPD-01 is filed by a Taxpayer? \
Once the Form GST CPD-01 is filed, following actions take place on the GST Portal:

Dashboard of Taxpayer and the concerned Tax Official(s) is updated with the record of the filed Application.
Status of the application on the GST Portal gets updated to "Compounding Application Submitted".

Taxpayer will also receive an intimation on his/her registered Mobile and email ID informing about the
successful filing of the application and the generated ARN.

The Application will land in the concerned authority's queue and he/she will take subsequent actions to

process it.

mhat happens on the GST Portal once a Reply is filed by a Taxpayer? \
Once the Taxpayer files a reply or a counter-reply, following actions take place on the GST Portal:
ARN Status on the GST Portal gets updated to "Reply submitted".
The concerned Tax Official(s) will be intimated about the filed reply via their registered email.
Dashboard of the Taxpayer is updated with the record of the filed reply. He/she can view it from the following
navigation: Services > User Services > My Applications > REPLIES.

Qashboard of all the concerned Tax Official roles is updated with the record of the filed reply. /




Filing Application for Compounding of Offence (Form GST CPD-01) and Taking Actions in
the Subsequent Proceedings

ﬁVhat happens on the GST Portal once the concerned authority allows the application for compounding? \
Once the concerned authority allows the application for compounding, following actions take place on the
GST Portal:
Dashboard of Taxpayer and the concerned Tax Officials is updated with the record of the issued Order.
Taxpayer and the concerned Tax Official will receive an intimation on their registered Mobile and email
informing them of the issued Order.

Qcatus of the ARN will get updated to "Compounding allowed". J

\

ﬁ\lhat happens on the GST Portal once the concerned authority rejects compounding?

Once the concerned authority rejects compounding, following actions take place on the GST Portal:

Dashboard of Taxpayer and the concerned Tax Officials is updated with the record of the issued Order.

Taxpayer and the concerned Tax Official will receive an intimation on their registered Mobile and email

informing them of the issued Order.

Qtatus of the ARN shall get updated to "Compounding Rejected" J
N

/"Once the concerned authority has allowed application for compounding, can he/she withdraw it?
Yes. After allowing Compounding, authority may also withdraw it, at any stage if he is satisfied that such
person, had, in the course of the compounding proceedings, concealed any material particulars or had given
false evidence. In this case status of the ARN shall get updated to "Compounding Withdrawn" and thereafter,

: no action could be performed by the Taxpayer or the concerned Tax Officials, on the withdrawn ARN. :




Filing Application for Compounding of Offence (Form GST CPD-01) and Taking Actions in

the Subsequent Proceedings
hat are the points | need to know before making payment of the Compounding Fee? \

Before you make the payment of the Compounding Fee, you should be aware of the following points:

You are required to pay tax, interest and penalty liable to be paid for which the application has been made.

You can pay Compounding Fee only when the concerned authority allows the application request.

You need to pay the Compounding fee within 30 days of the Order, otherwise, the Order will be vitiated and be

void.

You need to make payment of compounding fee through cash ledger only. ITC can be utilized for payment of tax
\inv. Payment of taxes will be as per the rules applicable.

_/
ﬁVhat happens once the Compounding Fee is paid? \
Once the Compounding Fee is paid, following actions take place on the GST Portal:

Status of the ARN gets updated to "Compounding Fee paid".

If the compliant has been filed with the Magistrate/Court of competent jurisdiction, the concerned Tax
official will withdraw the complaint.

If no complaint has been filed with the Magistrate/Court of competent jurisdiction, no further prosecution

Qroceedings shall be initiated. J
B

1 do not have sufficient amount in my Cash Ledger. How can | pay the Compounding Fee?
If you do not have sufficient amount in my Cash Ledger, you can create a Challan to deposit money in the Electronic
Cash Ledger. You can easily do so by clicking the "DEPOSIT IN CASH LEDGER" button available on the Payment FEE

\_page. %




Filing Application for Compounding of Offence (Form GST CPD-01) and Taking Actions in
the Subsequent Proceedings

@I submit a Rectification request against the Compounding Order issued by the concerned authority\
Yes. in case you notice an error apparent from the face of the order, you can file rectification application
against the Order passed by the concerned authority.

Additionally, note that:

* You can submit the Application for rectification within <three months> from the date of Order sought

to be rectified.

* No rectification shall be allowed after a period of six months from the date of issue of such decision or
Order.

* If the rectification is purely in the nature of correction of a clerical or arithmetical error, the limitation
of six months shall not apply. Thus, in this case (when the difference between the date of the Order and
rectification application filed is more than 6 months), the following information message pops up
asking for confirmation “Do you still want to file the Rectification application as the period exceeds 6

\months from the date of the order”. You can click the PROCEED button to move forward with filing the
application. J




Filing Application for Compounding of Offence (Form GST CPD-01) and Taking Actions in
the Subsequent Proceedings

What happens on the GST Portal once a Rectification request is submitted by a Taxpayer?

Once a Rectification request is submitted by a Taxpayer, the concerned authority may either accept the
request or reject it. However, in case the Order which need to be rectified has the effect of enhancing the
tax liability or reducing the amount of admissible input tax credit then, it cannot be passed unless the
Applicant has been given an opportunity of being heard.

* In case of Acceptance:
v" The concerned authority issues the Rectification Order. Dashboard of Taxpayer and the concerned Tax

Officials is updated with the record of the issued Order. Taxpayer can access the Rectification Order
from the ORDERS tab.
v’ Status of the ARN on the GST Portal gets updated to "Rectification order passed".

* In case of Rejection:
v" The concerned authority issues the Order. Dashboard of Taxpayer and the concerned Tax Officials is

updated with the record of the issued Order. Taxpayer can access the Order from
the RECTIFICATION tab.
v’ Status of the ARN on the GST Portal gets updated to "Rectification request rejected".




Filing Application for Compounding of Offence (Form GST CPD-01) and Taking Actions in
the Subsequent Proceedings

During the Compounding Application proceedings, what all Status changes does an ARN undergo?
During the Compounding Application proceedings, an ARN undergoes following Status changes:

* Compounding Application Submitted: When the Compounding Application is successfully filed by the Taxpayer

* Hearing notice issued: When hearing is issued to the Taxpayer or the P&C Officer or both

* Reply Submitted: When anyone (P&C Senior Officer/Assistant to Commissioner/P&C Senior Officer/Taxpayer) files
reply to the issued notice or a counter-reply

* Adjournment granted: When adjournment notice is issued (by the P&C Senior Officer/Assistant to Commissioner)
to the Taxpayer or the P&C Officer or both

 Compounding allowed: When the application for Compounding of offense is allowed by the P&C Senior
Officer/Assistant to Commissioner and order for compounding is issued

 Compounding Rejected: When the application for Compounding of offense is rejected

 Compounding Withdrawn: When the application for Compounding of offense is withdrawn by the P&C Senior
Officer/Assistant to Commissioner

* Rectification request submitted: When application for Rectification of an issued Order ("Compounding granted"
Order or "Compounding Rejected" Order) is filed by the Taxpayer or the P&C Officer

* Rectification request rejected: When application for Rectification of an issued Order ("Compounding granted"
Order or "Compounding Rejected" Order) is rejected by the P&C Senior Officer/Assistant to Commissioner

* Rectification order passed: When the Order is rectified by the P&C Senior Officer/Assistant to Commissioner

e Compounding fee paid: When the Taxpayer utilizes cash from the Electronic Cash Ledger to pay compounding fee




Thank you
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Prosecution and Compounding of Offences— Sec 134, 135, 136 & 137

COGNIZANCE OF OFFENCES [ Sec 134 ]

= Courts inferior than Magistrate of the First Class shall not declare the judgment for any
offence committed under this act .

PRESUMPTION OF CULPABLE MENTAL STATE [ Sec 135 ]

= Any offence under this act will be presumed to be done in a culpable mental state by
the court.

= However, the accused can defend himself by proving the fact he was not in such mental
state.

= A fact is said to be proved only when the court believes it to exist beyond reasonable
doubt and not merely when its existence is established by a preponderance of
probability.



Prosecution and Compounding of Offences— Sec 134, 135, 136 & 137

RELEVANCY OF STATEMENTS UNDER CERTAIN CIRCUMSTANCES [ Sec 136 ]

A statement signed by a person during the course of proceeding is relevant for proving
the truth of the facts in any prosecution for an offence under this act.

O

O

When the person who made the statement is :
Dead or cannot be found

Incapable of providing evidences

Restricted by the adverse party

Presence of the person requires time or expenses involved for presenting the person,
is considered unreasonable by the court .

When the person who made the statement is considered as a witness by the court,
the statement should be produced as a evidence in interest of the justice.



Prosecution and Compounding of Offences— Sec 134, 135, 136 & 137

OFFENCES BY COMPANIES [ SEC137]

Offence committed by a company

Every person who at the time of offence being committed was responsible for
the conduct of the business of the company shall be deemed to be guilty .

Proceedings shall be conducted accordingly.

If proved that the offence was committed with the consent of the key

managerial persons or negligence on their part , they shall also be deemed to
be guilty.



Prosecution and Compounding of Offences— Sec 134, 135, 136 & 137

Offence by Partnership Firm or LLP or a HUF or a Trust

The partners or karta or the managing trustee shall be deemed to guilty for offence
committed under this act.

If proved the offence was committed without their knowledge or measures were
exercised to stop such offence then they shall not be held liable



Compounding of Offences — Sec 138

Compounding not available in following circumstances:

> Compounding already allowed one time in respect of certain specified offences

Compounding allowed once shall not be allowed again if in previous
compounding, value of supplies > Rs. 1 Crore in offences not specified above

<

A person accused of committing any offence under this act which is an offence
under any other law

> A person convicted for an offence under this act by a court

fails to supply or supplies false information




Compounding of Offences —Sec 138

General Rules regarding Compounding -

C Compounding not to affect proceedings instituted under any other law

Compounding shall be allowed only after payment of taxes, interest, penalty for
such offence has been made.

C) Minimum Compounding amount = Rs. 10,000/- or 50% of tax involved

<:> Maximum compounding amount = Rs. 30,000/- or 150% of tax invoived

Upon payment, no further proceedings will be initiated and the accused person will
stand abated




Compounding of Offences — Sec 138
Procedure for Compounding -

{ Application shall be made to the Commissionerin - GST CPD - 01 J

" The Commissioner shall ask the concerned officer to furnish relevant )

. documents )

On satisfaction the Commissioner by order in FORM GST CPD - 02
|

Allow the application indicating A g Else he may reject it
the compounding amount and within 90 days of
grant him immunity receipt.

\_ from prosecution W, \_ W,




Compounding of Offences — Sec 138

Procedure for Compounding -

{ Compounding shall be allowed only after payment of taxes, interest and penalty }

4 I
Compounding amount shall be paid within 30 days from the date of receipt of order

o %

s R

Failure to pay the compounding amount shall lead to order being void

N /

4 . . . . . N
Immunity granted may be withdrawn anytime in case any material facts was concealed

by the applicant
N y
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